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WHAT IS SERIES 6? 
 
Series 6 is an Electronic Document Management System (EDMS), which manages all documents and 
communications arriving on your desk; paper, e-mails, web pages, faxes and electronic files. Using Series 6 
you can rapidly scan, import, file, retrieve and track all these documents via an easy-to-use and simple 
mode. 
 
Whether access is required to customer files, invoices, correspondence or to solve a compliance problem, 
Series 6 provides the answer to all kinds of administrative requirements. The product is based on the most 
up-to-date technology providing both huge scalability and future integration options.  
 
 
GUIDE INTRODUCTION 
 
This guide is intended to introduce Series 6 and help get you started. 
 
You will learn how to: 
 

 Switch to different Series 6 view Modes 
 Navigate the system 
 Understand the concepts 
 Bring documents into Series 6 
 File documents away 
 Quickly and effortlessly retrieve documents through Search and Explore 
 View the contents of a selected document  
 Make changes to a selected document 
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ACCESSING SERIES 6  
 
Open Series 6  
 
To launch Series 6 double click the Icon which will be located on the desktop. 
 

 
 
You will be automatically login to Series 6. 
 
 
Close Series 6 
 
Click the  button in the top right corner of window/toolbar (applies to all modes). 
 
 
THE SERIES 6 MODES 
 
When you open Series 6 you will be presented with one of three modes.  Depending on the privileges given 
by the System Administrator you may have them all or just one.  The three modes are: 
 

 Simple 
 Standard 
 Advanced 

 
Mode Name Screen Shot 

Simple 

 

The Simple mode provides a simplified way of working with Invu.  Search, My Work, Scan, Create 
and Resource Portal are the 5 main functions which are displayed as tabs across the top of the 
screen and each, in turn, has been uncomplicated with minimal options to confuse.  A Simple 
Mode user does not have the ability to Explore or configure Series 6 through Administration in this 
mode. 
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Standard 

 

The Standard mode has been provided with a floating toolbar.  Full functionality is available in the 
Standard mode Workspace, Search, Explore, Administration and Resource Portal.  Each Icon is 
presented in its own independent window. 

Advanced 

 

The Advanced mode is contained within a single window.  The style of the window has a similar 
feel to Microsoft Outlook giving you an environment that you may be familiar with.  Full functionality 
is available in the Advanced mode Workspace, Search, Explore, Administration and Resource 
Portal.  These Five functions are displayed as buttons on the left-hand side of the screen. 

 
Switching Modes 
 
Depending on the privileges set by the System Administrator you may be able to switch between Simple, 
Standard and Advanced Modes. 
 

Click the arrow to the right of the View options   icon and choose the mode to switch to.  The view will 
then change accordingly.  The mode you choose will be remembered as your chosen start mode. 
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SERIES 6 SCREEN LAYOUT 
 

 
 
 
 
 
 
 
 
Invu toolbar - enables the user to choose what action to carry out on a selected document such as View or 
Scan.  In the Simple Mode you can get access to these options via the right click menu. 
 
Left-hand pane  - shows the areas you can browse and if in the Search window, options on where and what 
to search on will be displayed.  The Other Intrays section is only available in the Standard and Advanced 
mode and if you have the correct privileges. 
 
Middle pane  - allows the user to view results from a search and browse documents which can then be 
Viewed, Edited etc. 
 
Right-hand pane  - this will allow the user to browse the File and Save information of a document, list 
favourites, view Intray shortcuts and when using the Search function, the location pane to locate a document. 
 
Function Buttons  - enables the user to switch between functions within the Advanced mode. In Standard 
mode these are displayed as a floating toolbar.  
 

Left-hand Pane 

Advanced Mode Function 
Buttons in the Standard 
modes these area on a 

floating toolbar 

Invu Toolbar only in 
Standard and 

Advanced 

Middle Pane 
Right-hand Pane 
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Using the Right-hand pane 
 
The Series 6 Right-hand pane enables the user to display information and notes on selected documents, 
view shortcuts to both user & folder Intrays and shows the user’s favourites.  The Right-hand pane is 
available in all 3 modes Simple (through the ‘Search’ and ‘My Work’ tabs), Standard and Advanced in all 
functions apart from Administration.    
 
There are four different panes to choose from as follows: 
 

 Summary and Notes 
 Intray 
 Favourites 
 Location 

 
Below these are explained in turn in this section. 
 
The Pane Layout 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Title Bar 
 
The Title Bar within the Right-hand pane displays the name of the pane which is open i.e. Summary and 
Notes Pane. 
 
 
 
 
 
 
 

 

 The Right-hand pane menu will allow the user to select which pane to display. 
 

Title Bar 

Right Pane Icons 

Title of current pane  
Right Pane Menu 

 Auto Hide 
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 The Auto Hide  icon enables the user to choose if the pane remains open permanently (pinned) or 
automatically hides when not in use.  By default the Auto Hide icon is switched off, which means the Right-
hand pane always remains open.   
 

To hide the pane click the Auto Hide   icon (unpin) and the Right-hand pane will hide straight away 
leaving a small pane of controls. 
 
To view a pane in Auto Hide mode move the mouse pointer directly over any Right-hand pane icon required 
this will automatically slide out.  It will also Auto Hide when not in use by sliding back. 

To turn off Auto Hide click the  icon. 
 
To move the Right-hand pane 
 
The Right-hand pane can be placed to the bottom, right or as a floating window in Invu. 
 
This pane by default will appear on the Right-hand side.  To move the pane to another position on the 
screen, move the mouse to the title of the pane i.e. Summary and Notes 
 
Click on the heading and drag the mouse pointer and the screen will change as below. 
 

 
 
Move the mouse over the appropriate marker and release the mouse.  The pane will then snap to its new 
position. 
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Summary and Notes Pane 
 

 Click the Summary and Notes icon, here you will be able to view information and notes on a selected 
document.          
 
The Summary and Notes pane has two main options which are located under the Thumbnail image or image 
icon: 
 

 Summary  
 Notes 

 
Summary Pane 

Click the Summary  information  icon to show the detail of a document selected such as a Thumbnail  
image (depending on the document) and Document Reference  information such as File and Save 
information (if the document has been filed away) and also a set of other document references.  The 
information may change depending on the document selected and its location. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Thumbnail 
 
A thumbnail will show a mini picture of the first page of the file.  The thumbnail is generated when the file is 
brought into Series 6 depending on the format and settings.  If a thumbnail is not generated for a file then an 
icon image is shown instead.  Below is how Series 6 determines whether a thumbnail should be created or 
not. 
 
Images files such as .jpg , .tif , .bmp  etc will always have a thumbnail. 

Email files .msg  will not have a thumbnail instead an icon picture  will be displayed. 
 
Text (.txt ) or delimited (.csv ) file types will not have a thumbnail instead an icon picture will be displayed. 
PowerPoint files will always display a thumbnail image. 
 

Thumbnail or 
Icon image 

Document 
References 
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Office documents Word and Excel will only show a thumbnail if the Office properties are set to show a 
preview picture. 
 
To turn on the Preview picture option in 2003, open the Word or Excel file then click the File  menu and select 
Properties . 
 

 
 
Tick the Save preview picture  option and click the OK button.  This can be done before the Word or Excel 
file is brought into Series 6 or after. 
 

If using Office 2007 then click the  button and from the menu select Prepare  then Properties .   
 

 
 
The Document properties area will be displayed under the main tabs click the arrow beside the heading 
Document Properties  and select Advanced Properties ...  
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Click the ‘Summary ’ tab. If you would like a thumbnail then tick the Save preview picture  check box. 
 
The Document References 
The Document Reference information is gathered from the file properties (there are four sets of these) and 
File and Save information entered in Series 6 (the picture below shows Training Manuals this is file and save 
information).   Depending on the file these may differ.  To view any of the document references click the 
white arrow to expand and the black arrow to collapse. 
 

 
 
Every file brought into Series 6 will have the Common Document References  this information is obtained 
from the file properties which you would look at through Windows Explore. 
 
Some files may have another set of Document References as below: 
 
Image Document References  - are created if the file is an image format such as .jpg, .tiff, .gif etc. 
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Office Document References - are created if the file is of Microsoft Word or Excel format.  This information 
is obtained from the properties within office. 
 

 
 
Mail Document References  - are created if the file is of an .msg  format.  The information will show the 
subject, who the email was to and from etc. 
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Notes Pane 
 
A notebook can contain many sections which could have multiple pages. 

Click the Notes  icon to View, Create, Edit and Delete notebooks or attachments.    
 

 
 
Create a Notebook  
 

 
 
To create a new note click the Add  menu and from the menu choose New notebook…  the following will be 
displayed: 
 

 
 
Enter the title for the notebook  and then enter the title for the first section .  Click the OK button to create 
the Notebook and the following will be displayed as shown on the next page: 
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The tab represents the section.  A section can have many pages if required and the text can be manipulated 
using the Menus and the Formatting Toolbar. 
 
You are able to copy text from other applications and paste it in as well as type text. 
 
Change the Page Title 
 
To change the name of the page, click onto the dotted area. 
 

 
 

Remove the text and enter the new name. The name of the page will be displayed on the right side of the 
'Notebook' screen as shown below: 
 

 
 
 
 

Formatting 
Toolbar 
 Section 

Tab 
 

Page Title 

Page 
Area 
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Create a New Page 
 

To create a new page, on the right side of the 'Notebook' screen click the  New option and from the 
menu choose the Page option or click the Notebook  menu then New… and then select the Section  option.   
 

 
 
A new page will be displayed as shown above.  Click the New page  text to open the page.  
 
To name the page, click into the dotted area with the text New Page just below the toolbar. 
 

 
 

Remove the text and enter the new name. The name of the page will be displayed on the right side of the 
'Notebook' screen as shown below: 
 

 
 
You can switch between the pages.  To switch click the Page Title on the right of the 'Notebook' screen. 
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Add a New Section 
 
A Notebook can have many sections.  To create a new section, on the right side of the 'Notebook' screen 
click the  New option and from the menu choose the Section  option or click the Notebook  menu then 
New… and then select the Section  option.   
 
The following screen will be displayed: 
 

 
 
Enter the name of the new section then click the OK button.  A new tab will be displayed as shown below: 
 

 
 

Click the tab title to switch between multiple tabs. 
 
Once your notebook is completed, click the X in the top right corner of the 'Notebook' screen.  The following 
message will be displayed: 
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Click the Yes button to save the changes.  The note created will be displayed in the Notes  pane as shown 
below: 
 

 
 
Notebooks are not the only thing you can use the Notes  pane for, you are also able to view Notes (created 
through the right click menu Create - Note ).  Notes are created as an XML file and cannot be edited (for 
more information on the Create - Note  option please see page 99.) 
 
When a Notebook or an attachment is added to a selected document a symbol will appear beside the title of 
the document. 
 

 
 

If the document has something attached then a  paperclip symbol will appear.  If the document has a Note 

or Notebook then a  page symbol will appear.  Both the symbols can appear together see the image 
above. 
 
To Create an Attachment 
 
To create a new attachment click the Add  menu and from the menu choose New Attachment… the 
following will be displayed: 
 

Attachment 

Note 

Notebook 
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Browse to the document you wish to attach, this can be located in your Intray or a filing cabinet location. 
 
Highlight the document to be attached as shown on the next page:   
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If you want to select multiple documents highlight the first document then hold down the CTRL key and click 
each subsequent document.  If the documents you wish to select are in a block then highlight the first 
document then hold down the SHIFT key then click the last document in the block. 
 
Once the document(s) have been highlighted, click the OK button to attach the document(s).  
 
View any Note or attachment 
 
Any Note, Notebook or attached document can be viewed from the Notes  pane.  To open a Note, Notebook 
or attachment double click the name or right click the title of the Note, Notebook or attached document.  
From the menu select the Open… option. 
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The Note, Notebook or Attachment will then be opened to view.  When finished click the X in the top right 
corner of the screen to close. 
 
Print a Notebook, Attachment or Note 
 
To print a Notebook, Attachment or Note, right click the title of the Notebook, Attachment or Note  
 

 
 
From the menu select the Print  option.  The following will be displayed: 
 

 
 
Select the printer and number of copies then click on the Print  button.  The document will then be printed. 
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Edit a Notebook 
 
To edit a Notebook right click the title of the Notebook. 
 

 
 
From the menu choose the Edit…  option and the 'Notebook' screen will be displayed. 
 

 
 
You cannot add or change the text on existing pages.  To create a new page, on the right side of the 

'Notebook' screen click the  New option and from the menu choose the Page option or click the 
Notebook  menu then New… and then select the Section  option.   
 
A new page will be displayed as shown above.  Click the New page  text which is displayed to the right of the 
screen to open the page.  
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To name the page, click into the dotted area with the text New Page just below the toolbar. 
 

 
 

Remove the text and enter the new name. The name of the page will be displayed on the right side of the 
'Notebook' screen. 
 
When you have added the text to the new page, click the X in the top right corner of the 'Notebook' screen. 
 

 
 
Click the Yes button to save the changes to the Notebook. 
 
Mark as Read 
 
When you create a new Notebook it will mark it unread (it will appear bold and in blue) if added to a 
document in an Intray. 
 
To mark a note as read, right click the note as shown below. 
 

 
 

From the menu select the Mark as Read  option.  The note text will change to none bold black text. 
 
Remove a Notebook 
 
To remove a Notebook, Attachment or Note, right click the title of the Notebook, Attachment or Note  
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From the menu select the Delete option.  The following message will be displayed: 
 

  
 

Click the Yes button to delete the selected file. 
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Intray Shortcuts Pane 
 

 Click the Intray Shortcuts icon, this pane allows you to create shortcuts to other user’s and folder Intrays.  
This gives users the facility to move and/or copy documents into another user’s Intray. 
 

 
 

There are three types of Intray you can create a shortcut to: 
 

User Intray – each user will have an Intray for documents that are brought into Series 6.  So you are 
able to setup a shortcut and send colleagues copies or move documents to their Intray. 
 

Group Intray – these are a group of users within Series 6 but only show if your administrator has 
created them.  These are great as if you send a document to a Group Intray all members of that group can 
see it. 

Folder Intray – These are basically linked to the Folders in the filing cabinets.  If a document is send 
to a folder Intray all users who are a member of that folder will be able, at least to see the document. 
 
You can create an Intray shortcut to any Intray and send shortcuts to documents or even move the document 
to another user’s Intray. 



 
 

  
Invu Services Limited © 2009 

Page 29 of 221 
End User Manual V 6.2.3 

 

To create a new shortcut: 
 

Click the arrow beside the Add   icon and from the menu choose one of the following options: 
 

 
 
A screen will be displayed with a list of Users or Groups or Folders depending on the option chosen from 
above the screen: 
 

 
 
Expand the sections and then highlight the User\Group\Folder Intray and click the OK button.  Multiple 
shortcuts can be created by holding down the CTRL key and mouse click to select multiple users/folders.  
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To remove an Intray shortcut: 
 
Highlight the shortcut to be deleted as shown below: 
 

 
 

Click the  Delete icon and the shortcut will be removed. 
 
To Change the Intray Shortcuts View: 
 

Click the arrow beside the  icon and the following menu will be displayed: 
 

 
 
 
The All , Users , Groups  and Folders  options will allow you to choose which types of Intrays you would like 
to see.  You can also choose to view the Intray Sortcuts as Large Icons  (default) or Small Icons (as shown 
below). 
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If you choose the Group By Type  option the Intrays will be group by type as shown below: 
 

 
 

The Group By Type  option can also be used when viewing Intray Shortcuts as Large Icons .  
 
 
Move or Copy a document to another Intray:  
 
Copies (shortcuts) to documents can be added from the Filing Cabinets folders or your Intray. 
 
Highlight the relevant document.  If you wish to select multiple documents then click the first document as 
normal then hold down the CTRL key and click each subsequent document you require or if you wish to 
select a block click the first document then hold down the SHIFT key and click the last document in the block. 
  

 
 
Move your mouse pointer over the highlighted document then click and drag the selected document over the 
Intray shortcut within the Intray shortcuts pane and release your mouse.  The screen shown on the next page 
will be displayed: 
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Within the area called Would you like to… choose Copy this item to the Intray (leaving a copy in 
yours)? option, this will create a shortcut in the destination Intray but the user viewing the shortcut must 
have access to the Intray or folder where it originally came from.  Choose Move this item to the Intray 
(removing it from yours)?  option, this will move the original from your Intray to the destination Intray and is 
not available when dragging a document from a folder. 
 
Type a note into the area below the toolbar, if required, and then click the OK button. 
 
NB:  Within the Simple mode users will not have access to folder or Other User's Intrays.  However a user will 
still be able to drag and drop documents into the Intray Shortcuts Pane from their own Intray. Within the 
Standard and Advanced modes you will be able to browse folders and other user's Intrays depending on the 
permissions set by an Administrator. 
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Copy a document to Multiple Intrays:  
 
You can also copy a selected document(s) to multiple Intrays. 
 
First you will need to select the Intrays. 
 

 
 
To select multiple Intrays click the first as normal then hold down the CTRL key and click each subsequent 
Intray you wish to select. 
 
Highlight the relevant document.  If you wish to select multiple documents then click the first document as 
normal then hold down the CTRL key and click each subsequent document you require or if you wish to 
select a block click the first document then hold down the SHIFT key and click the last document in the block. 
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Move your mouse pointer over the highlighted document(s) then click and drag the selected document(s) 
over the highlighted Intray shortcuts within the Intray shortcuts pane and release your mouse.   
 

 
 
You can only copy a selected document to multiple Intrays, enter a note if required then click the OK button. 
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Favourites Pane 
 

 Click the Favourites icon, and here you will be able to create shortcuts to documents.  This makes it 
easier for the user to find and open documents that are used on a frequent basis. These favourites can be 
split into sections to make it even easier to manage. 
 

 
 
To add a document to Favourites: 
 
Highlight the document(s), in the Middle pane in any mode, to be added to Favourites as shown below: 
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Right-click the highlighted document and from the menu select Send To  then click the Favourites  option. 
The shortcut will then be created in the pane under the section New Items . 
 

 
 
Within the Favourites  pane you can create new sections, rename a section or shortcut, move shortcuts to 
different sections and delete shortcuts. 
 
To view a document, double-click the required shortcut in the Favourites  Pane. 
 
 
To create a new section: 
 

Click the Create a new section  icon and following dialogue will be displayed: 
 

 
  
Enter the new section name into the text box and then click the OK button. 
 
 
To move a shortcut to a different section: 
 
Highlight the required document in Favourites  pane as shown below: 
 

 
 

Then click the  icon and the following will be displayed: 
 

 
 
Type in the name of the section the shortcut should be moved to but ensure you enter the exact spelling and 
case.  If the section does not exist, a new section will be created automatically. 
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Click the OK button to move the document to a new section as shown below: 
 

 
 
To rename a shortcut or section 
 

Click the section title or shortcut to be renamed in the Favourites  pane and then click the  icon.  
The following dialogue will be displayed: 
 

 
 
Enter the new name into the text box and click the OK button. 
 
To remove a shortcut or section 
 

Highlight the required section or shortcut within the Favourites pane then click the  icon. 
 
The shortcut or section will be removed. 
 
NB:  If you delete a section heading then any shortcuts under that section will also get deleted. 
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Location Pane 
 
This pane is only available when using the Search function.  A search would be performed then you would 
use the Location pane to find where the search results are located in the Filing Cabinet Folder or a user’s 

Intray.  To view the location of results in the Right-hand pane click the Results Location   icon and the 
following will be displayed: 
 

                                                        
 
To view the location of a document select the specific document in the Middle pane and the location pane 
will display where the document is in Series 6. 
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The Middle Pane Views, Sorting and Columns 
 
The Middle pane will display documents for a selected area.  Each document is displayed showing a file type 
icon. 
 

 
 
You can tell the difference between a single page .tif and a multiple page .tif files as shown below: 
 

  A single page .tif 

 A multiple page .tif 
 
View menu 
 
There are several ways in which to display documents within the Middle pane.  To customise the way 
documents are displayed, right click in the Middle pane on one of the following areas;  
 

 Simple Interface  in Search  or My Work  
 Standard & Advanced Interface  in Explore , Workspace  or Search  

 
In the right click menu select the View option and the following cascade menu will be displayed: 
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Click an option to activate showing a tick to the left of the text.  Below are the details on each option: 
 
Details  
 
The Details  option when selected displays details about each document such as Title, Version, Creator, 
Owner, Last Modified, Created etc these headings may change depending on the Information Type and 
Standard Document if the file is located in the filing cabinets rather than an Intray.  This view is the system 
default. 
 
To display the details view, right click on the Middle pane anywhere, from the menu select the View option 
and then click the Details  option. Below is an example of the Details view in the Middle pane. 
 

 
 
Thumbnails 
 
The Thumbnail  option will change the view to show mini images of each document depending on the format. 
 

 
 
To display the thumbnails view, right click on the Middle pane, from the menu select the View option and 
then click the Thumbnails  option.  The above picture shows an example of thumbnails view in the Middle 
pane, if a document has no thumbnail to display then the text 'Thumbnail not available ' is displayed. 
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Columns 
 
The Column  option enables the user to choose the order of column headings for each Standard Document 
within Invu.  Once selected the following screen will be displayed: 
 

 
 
From the drop down list choose the Standard Document you wish to change the order of the heading for and 
a list of columns will be displayed.  Highlight the column that needs to be moved and then click either the 
Move up  or Move down  buttons. 
 
Drag and Drop Columns 
 
You are able to drag and drop the column headings to choose the order you wish to see in the Middle pane.  
Each Standard Document will have its own set of headings as shown below: 
 

 
 
Move the mouse pointer over the column heading you wish to move hold down the left click button and drag 
to new location, as you drag to the new location a grey box will appear with the name of the column as 
shown below: 
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Hover over the title you wish to move the drag column to then release the mouse the drag column will be 
placed moving the existing column. 
 

 
 
It will remember the columns moved the next time you log in. 
 
All versions 
 
When a document is checked out and checked back in the version number will increment by default.  Invu 
will only display the latest version of the document by default but if the user wishes to see all versions then in 
the Middle pane right click and from the menu select the View option and click the All versions  option.   If 
you select the same option again it will revert to showing the current version only. 
 
Expand all Sections / Contract all Sections 
 
When using the Middle pane you can expand or collapse the document sections.   
 
To expand and view all documents, right click in the Middle pane and from the menu choose the View option 
and then select the Expand all sections option. 
 
To contract all sections right click in the Middle pane.  From the right click menu choose the View option and 
then select the Contract all sections  option. 
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Sorting Documents 
 
The Middle pane of Explore , Workspace  and Search  can be sorted into ascending/descending order. 
 

 
 
You are able to sort each of the Standard Document Headings.  In the picture above you could sort the 
Demonstration Documents by Version and the Understanding Documents by Author. 
 

 
 
Expand the section to display the documents.  The grey row below the Standard Document Heading displays 
the headings for the Document References.  Click once on a heading. In the example on the next page the 
version heading was clicked.   
 

 
 
A small blue arrow will be displayed to the right of the heading text this has now been sorted into ascending 
order.  Click the heading again to sort into descending order. 
 

 Ascending order 
 

 Descending order 
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The Function Buttons for Advance Mode 
 

 
 
On the Left-hand pane of the Advanced mode are the buttons to switch between Workspace, Search, 
Explore and Administration.  To switch functions, simply click on the required function.  The buttons can be 
customised to suit the individual user. 
 

 
 
To change the function buttons from text and image to image icons only move the mouse pointer over the 
dark blue bar above the buttons as shown in the picture above.  A double headed arrow will be displayed.  
Hold the left mouse button and drag down until a small image icon bar appears as shown below: 
 

 
 
To change the functions button back to text and image, hold the left mouse button and drag up until the text 
and image icon bar appears. 
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Workspace 
 
The Workspace brings together the user’s Intray, Work Tasks, Email and Current Documents.  It is intended 
to be the area where a user works with their documents on a daily basis.  
 
In the Simple mode the Workspace area is known as ‘My Work’ .  Click the 'My Work ' tab to access the 

Workspace area.  To access the Workspace in the Standard Mode click the  button on the floating 

toolbar or within the Advanced mode click the  button on the Left-hand pane. 
 

 
 
Within the Left-hand pane the user can explore all areas within the Workspace.  To do this, use the white 
arrows to expand and the black arrows to collapse areas. 
 
If using the Simple mode you do not get the Other Intrays area in the Left-hand pane. 
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Current Documents 
 
Current Documents will be displayed when you have documents checked-out.  A user can also send 
documents from the Filing Cabinets to their own Current Documents, so that the document becomes easily 
available to them at a later date or Offline.  
 
The Current Documents area is also available to the user ‘off-line’, so that these documents are accessible 
when they’re not connected to the network (or Internet). The system detects if the network is available at the 
point of starting the system, if no network is available the system will work in off-line mode. 
 
Email 
 
Invu can integrate with IMAP4 compliant email systems (such as MS Exchange) and the Email section of the 
Workspace  screen will show the content of the user’s mailbox (all mail folders). Emails can then be 
organised easily within Series 6. 
 
Work Tasks 
 
Work Tasks will present the current tasks assigned to the user in an S650 system through the Workflow 
module. 
 
Intray 
 
The Intray brings together documents which have been brought into the Invu system, but have not yet been 
filed and saved. A user has a personal Intray and have access to folder/group Intrays in the Standard and 
Advanced Mode.   If a document is sent from another user or other part of the system it will be placed into 
the Intray as unread and behave in a very similar way to Outlook. 
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Users can send documents from their Intray(s) to other users’ Intrays for review or collaboration (for 
example).  
 
Search Intrays 
 
The Search Intrays area will allow you to see only unread documents in all Intrays you have access to  
 

 
 
Grouped by Intray types as shown above. 
 
Other Intrays 
 
The Other Intrays section is only displayed in the Standard and Advanced mode but only if you have the right 
privileges applied.  This section will allow you to see other  User Intrays you have been given access to,   
Group Intrays you are a member of and also any  Folder Intrays where you are a member of the Folder in 
the Filing Cabinet. 
 
This section is only for viewing the contents of the Intrays, if you wish to send a copy or move a document 
from your Intray to another then use the Intray Shortcuts Right-hand pane (please see page 28).  You can 
work with the documents and even File and Save the document away if you have the right security applied. 
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Explore 
 
Series 6 enables the users to explore the system for documents and information.  This provides the user with 
the ability to explore the Filing Cabinets, folders, any Intrays available and their Workspace.  It performs a 
similar function to MS Windows Explorer (hence the name!) and allows users to ‘drill-down’ within the Invu 
hierarchy and browse the contents of available locations. This provides an alternative method of accessing 
the electronic documents and information over searching, using criteria.  
 
However the Explore  function is only available within the Standard and Advanced mode. 
 

To access the Explore in the Standard mode click the   button on the floating toolbar or within the 

Advanced mode click the  button on the Left-hand pane. 
 

 
 
Within the Left-hand pane there are two different views available depending on how the System 
Administrator has set the system. 
 
The first view is the Explore area which allows the user to see the Workspace and Filing Cabinets all located 
in one section as shown on the next page: 
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In the Left-hand pane the user can explore all areas they have access to.  To do this, use the white arrows to 
expand and the black arrows to contract areas. 
 

 
 
To view documents in a specific location, expand the Filing Cabinet and the relevant folder if applicable.  
Then click the folder and the documents will be displayed in the Middle pane. 
 
The second view splits the Filing Cabinet and the Workspace into two sections. The Workspace section will 
allow the user to explore Current documents, Email, Work tasks and Intray.  The Filing Cabinets will allow 
the user to explore Filed and Saved documents. 
 

 
 
The Filing Cabinet section will allow the user to choose from drop down lists.  The reason for this is to enable 
systems with larger tree structures to explore with ease (as shown in the picture above). 
 
To view a certain folder within the Filing Cabinet click the first drop down and choose or start to type in the 
name of the required Filing Cabinet. 
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A second drop down will then be displayed, populated with all related folders. On the next level down, again 
choose or start to type the name of the required sub folders.  If there are further levels in the Filing Cabinet 
another drop down will appear. 
 
 
Search 
 
Series 6 allows you to search for documents in Intrays and folders you have access to.  Depending on the 
modes you have you will be able to search in specific folders or Intrays, choose what you search for and also 
search the content or Document References relating to the document.  
 

 
 
You can save a search and also view up to the last ten searches that have been performed.  If using the 
Simple mode to search it is a very simple 'Google' style search bar but you do not get to choose where or 
how it searches. 
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Administration 
 
All configuration of the system is done via the Administration function, which is only available in the Standard 
and Advanced modes.  Some users may not be able to view this function depending on the membership they 
may have and this is set by the System Administrator. 
 
To access the Administration function, if using the Standard mode click the button  on the floating toolbar 
or if using the Advanced mode click the  on the Left-hand pane. 
 
In order to make changes to the Invu system the user has to be logged on as a user who is a member of the 
Administration group otherwise no changes can be made. 
 

 
 
For more information on Administration of the Invu system please refer to the Administration Manual. 
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Resource Portal 
 
The Resource Portal will allow you to learn how to use Series 6 by means of Manuals, Videos Demonstration 
and Understanding. 
 

 
 
For more Information please visit the Resource Portal.  Log into Series 6 as normal then click the 

  function if using the Advanced mode, if using the Standard mode click  icon on the 
Toolbar or if using the Simple mode click the ‘Resource Portal ’ tab. 
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USING THE INTRAY 
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USING YOUR INTRAY 
 
Accessing your Intray 
 

To access your Intray click the  button. To view documents within the Intray, click the 

text or grey image  in the Left-hand pane and the documents will be displayed: 
 

 
 
When you bring files into Series 6 normally they would be displayed in your Intray.  There are many different 
ways to bring a file into Series 6  
 
Unread and Read Documents 
 
You have a unread/read feature on documents that are brought into any Intray you have access to.  If you 
have unread documents the number will be displayed in brackets as shown below: 
 

 
 
If a document is sent an Intray they will marked as unread and appear in Blue and Bold  but, if checked out 
Red and Bold  and if a draft then Green and Bold . 
 
Unread documents will be displayed as normal black text. 
 
If you have unread documents which you did not bring in then a popup is shown in your system tray notifying 
that you have unread items. 
 
An icon is also displayed in your system tray as shown below: 
 

 
 
If you hover your mouse over this icon a tool tip will appear with the number of unread items. 
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When a document  has been viewed then it is marked as read.  If you wish to manually mark a document as 
read then right click the document or if you have multiple documents click the first document and then hold 
down the CTRL key and select each subsequent document until all required are highlighted the right click 
one of the highlighted documents.  From the menu select the Mark as Read  option. If you wish to manually 
mark a document as Unread then right click a read document then from the menu select the Mark as 
Unread  option. If you wish to make all documents in your Intray then right click the Intray name and from the 
menu select the Mark All as Read option. 
 
You can also display only unread documents by using the Search Intrays option which will show you all 
Intrays you have access to grouped by type showing the number of unread documents in brackets as shown 
below: 
 

 
 

If you do have access to other Intrays then you will see the documents as unread even if the document has 
been read by the user who owns the Intray/or another user who has access, this applies no matter the Intray 
belongs to a User, Group or Folder.  If you wish to make all documents in any of the Search Intrays area 
then right click the type of Intray name and from the menu select the Mark All as Read  option. 
 
Bring an Electronic Document into Invu 
 
An electronic document can be placed into Series 6 by simply dragging and dropping the document into your 
Intray. 
 
To drag and drop a file, first click the  option within the Workspace area.  In the top right corner of the 
window click the Restore  button so the Windows desktop can be seen.  
 
Click and drag the document into the Middle pane area of the Intray and release the mouse button.  The 
document will be available to be filed and saved. 
 
Another way to bring an electronic document into Series 6 is to right click a document on your Desktop , 
Windows Explorer  or My computer  and from the menu select the Send to  option. 
 

 
 

From the menu click the Series 6 File and Save  option to send the document into Series 6 and File and 
Save it away or click the Series 6 Intray  option to send the document directly to your Intray. 
 
Allow Other Users to Access Your Intray 
 
You can enable other users to have access to your Intray; this is known as the Connect Users option.  
Users are able to then work with the documents in your Intray (depending on the permissions given).  
 
To Connect Users, right click the Intray in the Left-hand pane.  
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From the menu click the Connect Users  option and the 'Intray Access' screen will be displayed: 
 

 
 
This screen shows who has access to your Intray at present.  More members can be added applying 
different access rights and also members can be deleted or have access rights changed. 
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To Add a Member and Assign Access Rights 
 
Click the Add  button and the ‘Groups and Members’ screen will be displayed as shown below: 
 

 
 
Expand the section and the highlight the member (user/group) who needs to have access.  If multiple 
members are to have access highlight the first member, hold down the CTRL key and select each 
subsequent member.   
 
Once the relevant members have been selected, click the OK button to return to the 'Intray Access' screen. 
 

 
 
Once the members have been added to the list, rights will be given automatically to browse and open 
documents from the Intray.   
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To apply more access rights, highlight the member from the list.  On the right side will be a list of member 
access rights, tick the relevant rights.  The access rights are as follows: 
 

Access Right  Description  
OpenDocument  Allows the members to open all documents with in the Intray they 

have access to. 
EditDocument  Allows the user to make changes to the document in the Intray they 

have access to. 
DeleteDocument  Allows the user to delete documents in the Intray they have access 

to. 
ViewMetadata  Allows the user to view all attributes associated to a document in the 

Intray they have access to. 
ViewEventHistory Allows the user to view what has happened to the document this 

feature is accessed from the right click menu - Properties. 
Full Control Allows the user all above rights to Intray 

 
 
Folders in the Intray 
 
You are able to create folders within your Intray very much like in Windows explorer but this does depend on 
the privileges given by the System Administrator. 
 
Create Folder in your Intray 
 
To create a folder, right click the Intray or an existing folder in the Left-hand pane.  
 

 
 
From the menu click the Create folder  option and the 'Create folder' dialog box will be displayed: 
 

 
 
Enter the name of the new folder and click the OK button.  The folder will be created and displayed below the 
Intray or folder. (As shown on the next page) 
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Delete an Intray Folder 
 
To delete a folder, right click the folder: 
 

 
 

From the menu select the Delete folder  option and the following message will be displayed: 
 

 
 
Click the Yes button to delete the folder.  Click the No button to abandon deletion. 
 
NB:  Folders can also be added to existing folders. 
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WEB PAGES INTO SERIES 6 
 
When browsing the Internet Web pages can be placed into Series 6.  
 
Open Windows Internet Explorer and browse to the desired web page. 
 

 
 

Click the  icon  
 
OR 
 
If you are using Internet Explorer 7 then to access the click the   icon on the right side of the browser 
window in the tool bar area and the following will be displayed: 
 

 
 

Click the Series 6 option.
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No matter what version of Internet Explorer you are using the following dialogue box will be displayed: 
 

 
 
In the area 'Capture Type' choose either Web Archive, single file (MHT) which will create one file with all 
images embed inside or Web Page, complete (HTML) which will create a html zip file this can consist of 
several files depending on the contents of the web page.  The drop down list displays which page is selected 
ensure the right address is selected, and then click the Capture  button.  The web page is then brought into 
your Intray as shown below: 
 

 
 
 



 
 

  
Invu Services Limited © 2009 

Page 62 of 221 
End User Manual V 6.2.3 
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FILE AND SAVE 
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UNDERSTANDING FILE AND SAVE 
 
A document when brought into Series 6 normally goes to your Intray.  You will need to File and Save it into a 
Folder location in a Filing Cabinet in order for another user to be able to work with it.  Before you learn how 
to file and save you need to understand the information required to do that. 
 

 Location - Filing Cabinet and Folders 
 Information Types 
 Standard Documents 
 Document References 

 
Filing Cabinet and Folders 
 
Within the Filing Cabinets location separate filing cabinets can be 
created.  These form the basis and structure for the Series 6 system 
and specifically the way in which documents are stored and organised.   
 
Filing Cabinets are configured by an Administrator and are displayed in 
a folder hierarchy structure as shown on the right.   
 
Information Types 
 
Information Types are the category of a document and are used when filing the documents/information away 
into the Filing Cabinets.  An Information Type is defined by the Administrator and is used to categorise a type 
of document.  An Information Type is associated with folder(s) within the Filing Cabinets, and this dictates 
the hierarchically where the document will be stored or referenced. 
 
Standard Documents 
 
A Standard Document relates directly to an Information Type and is used to provide classification (sub 
category) for that variety of document. 
 
As an example ‘Letter’ could be defined as an Information Type with ‘Acceptance Letter’, ‘Inquiry Letter’ and 
‘Letter of Complaint’ being three related Standard Documents.  A customer could also choose to work with 
‘Invoice’ as an Information Type and categorise ‘Purchase Invoice’ and ‘Sales Invoice’ as Standard 
Documents.  As an alternative, a more general approach could be taken and ‘Purchasing Document’ could 
be setup as the Information Type with ‘Purchase Invoice’, ‘Credit Note’, and ‘Purchase Order’ etc being 
defined as Standard Documents. 
 
Document References 
 
Document References add further detail when filing the documents into the Filing Cabinets.  Document 
References are associated with the Standard Documents, which means each Standard Document can have 
a differing set of Document References.  There is no set number as to how many Document References 
should be associated with a Standard Document; one Standard Document may have five Document 
References, another nine and a third just one. 
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FILE AND SAVE DOCUMENTS 
 
Once a document has been brought into Invu it can be placed into a user or folder Intray.  A document in an 
Intray can only be accessed by you and the users you connect.  In order to make the file available to a wider 
audience you must file the document into the Filing Cabinet this is known as File and Save .  In any of the 
modes you are able to File and Save  as long as you have the privilege to do so. 
 
When you choose to File and Save  you will need to specify the File and Save Information; what type of 
document it is (Information Type), where it will be stored in Invu, the Standard Document (sub category) and 
the Document References.  For more information on File and Save Information please see page 64. 
 
There are different ways to file and save a document depending on the mode. 
 
To File and Save a Document 
 
First you will need to select the document(s) you wish to file and save.  To access your Intray click the 

 button. To view documents within the Intray, click the text or grey image  in 
the Left-hand pane and the documents will be displayed.  Highlight the document required by clicking the title 
once in the Middle pane no matter what mode you are working in. 
 

 
 
Once the document has been highlighted you are ready to File and Save: 
 

 If using the Simple mode click the  button in the Right-hand pane. 
 

 If using Standard or Advanced mode, click the  icon on the toolbar which appears at the 
top of the screen. 
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 Using any of the three modes, right click the document in the Middle pane and from the menu select 
the File and Save  option. 

 

 
 
No matter which method is used the 'File and Save Document' screen will be displayed. 
 
The file and save views are set by an administrator or a user with similar admin rights and can vary 
depending on the company’s needs.  There are two different ways to view the 'File and Save Documents' 
screen: 
 

 Original File and Save screen (default) 
 Customised Order and Text File and Save screen 

 
Original File and Save Screen Right-Hand Pane 
 
The document to be filed and saved is displayed along with the File and Save Right-hand pane.  There are 
five steps to filing and saving a document away.   If you wished to save a Training Outline document you 
would follow on the next page: 
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Step 1 - What sort of document is this?  This is where the Information Type is selected.  This could be 
Marketing Materials, Training Documents or Product Documents etc.  Click the drop down list and choose 
the required Information Type. 
 
Step 2 – Choose a filing location for the document .  This is determined by what type (Information Type) 
of document has been selected in the previous step.  I.e. If Training Material was selected the user would be 
able to place it in the Training filing location.  To expand the relevant filing cabinet, click the white arrow.  A 
list of available folders will be displayed, click the folder you wish to save the file into so it is highlighted as 
shown: 
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If the System Administrator has given you the privilege you are able to create folders using the Create 
Folder  button.  Click the Create Folder  button and the following will be displayed: 
 

 
 
Enter the name of the new folder then click the OK button the folder will be created in this case under 
Training. 

 
 

 
Step 3 – Choose a Standard Document .  This is determined by what sort of document (Information Type) 
has been selected in Step 1.  I.e. if Training Materials was chosen as the Information Type, then you would 
be able to choose from related Standard Documents such as Outline or Training Manual etc.  Click the drop 
down list and choose the required Standard Document. 
 
NB:  If there is only one Standard Document then it will be selected automatically. 
 
Step 4 – Enter the Document Reference Information .  Once the Standard Document has been chosen the 
Document Reference information will be displayed (this can vary based on the Standard Document).  I.e. If 
the Standard Document chosen was Outlines you may need to enter the Title only. 
 

 
 

Fill in the Document References.  If a field is mandatory a  symbol will be displayed to the right of the 
field.  This means an entry must be made in order to continue filing and saving. 
 
If you have a reference which starts with the word List:  then that means you have to pick the value from the 
drop down list rather than entering it manually. 
 

 
 
Also, if configured, you are able to search a Fixed list.  You can type in W it will then display only a list of 
values in the list that contain the letter W as shown below: 
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This is very useful if you have very large lists to search through.  If not configured the list will always appear 
in full no matter what has been typed. 
 
If there are multiple fixed list in the file and save screen then a feature called linked lists can be used (if 
configured).  
 

 
 
For example choose the Customer Number and the Company Name and Contact will be completed 
automatically if only one value if linked thus saving time completed fields manually. 
 

 
 

If the contact name did not complete there may be more than one contact to choose from for that customer 
number. 
 
If you need to enter a date then you will need to click the drop down arrow and a calendar will be displayed: 
 

 
 
Click the date required and the field will be populated as shown below. 
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Step 5 – Press 'File and Save' to store . Once you have completed the File and Save Panel, click the File 
and Save  button to move the document from the Intray into the selected folder. 
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Customised File and Save Screen Right-Hand pane 
 
The document to be filed and saved is displayed along with the Files and Save Right-hand pane.  In this File 
and save screen the steps are replaced by simple worded instructions which can differ depending what the 
administrator has set for the order and the wording but the principle is the same. 
 

 
 

When choosing the Folder location you may choose from a tree structure 
showing yellow folders which you can expand by 
clicking the white arrows and collapse using the 
black arrow, then highlighting the Folder where 
you would like to store the document as shown to 
the right. 
 
Or you choose from a drop down box the Filing 
Cabinet, and then in another drop down below 
choose the folder.  Each time a folder is chosen 

another drop down may be displayed depending on the sub structure.  The 
example to the left shows four drop downs to get to the final location of 
Technical Training. 
No matter how the folders are shown and selected click the Confirm  button to 
move to the next set of instructions. 
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A green tick will appear beside each line as you have chosen the relevant option.  In the example above The 
Information Type has been selected automatically as there was only one.  If there is more than one then click 
the drop down and choose the relevant Information Type. 
 
Then choose the Standard Document again from a drop down box and the Document References will 
automatically be displayed: 
 

 
 

Fill in the Document References.  If a field is mandatory a  symbol will be displayed to the right of the field.  
This means an entry must be made in order to continue filing and saving. 
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If you have a reference which starts with the Word List:  then that means you have to pick the value from the 
drop down list rather than entering it manually. 
 

 
 
Also, if configured, you are able to search a Fixed list.  You can type in W it will then display only a list of 
values in the list that contain the letter W as shown below: 
 

 
 
This is very useful if you have very large lists to search through.  If not configured the list will always appear 
in full no matter what has been typed. 
 
If there are multiple fixed list in the file and save screen then a feature called linked lists can be used (if 
configured).  
 

 
 
For example choose the Customer Number and the Company Name and Contact will be completed 
automatically if only one value if linked thus saving time completed fields manually. 
 

 
 

If the contact name did not complete there may be more than one contact to choose from for that customer 
number. 

 
If you need to enter a date then you will need to click the drop down arrow and a calendar will be displayed: 
 

 
 

Click the date required and the field will be populated as shown to the right. 
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NB:  The above instructions can be in a different order depending on the configuration 
 
Once the File and Save information is complete click the File and Save  button to move the document from 
the Intray into the selected folder. 
 
File and Save Menu Options 
 

 
 
No matter which file and save screen you are using you have the option to control what will be remembered 
for the next you wish to file and save a document.  With the 'File and Save' screen click the File and Save  
menu at the top and you are able to: 
 

 Retain Indexing Values 
 Refresh Drop down Lists 
 Retain Index folder 

 
The Retain Indexing Values  option will remember all of the options selected and text entered for the next 
time you want to file and save.   This would be very useful if you were saving the same type of document on 
a regular basis. 
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To change the option you must be in the 'File and Save document' screen as shown to the right.  Click the 
menu File and Save  and from the list choose Retain Indexing Values a tick will appear beside the option so 
that you will know if it is switched on. 
 
The Refresh Drop Down Lists  option will refresh all drop down list for selected Document Type.  This is 
very useful if other users have added new entries since you have opened the 'File and Save Document' 
screen. 
 
To change the option you must be in the 'File and Save document' screen as shown on the previous page.  
Click the menu File and Save  and from the list choose Refresh Drop Down Lists this can be repeated as 
often as you need to. 
 
The Retain Index Folder  option will remember the folder location chosen for the next time you want to file 
and save.   This would be very useful if you were saving documents into the same location on a regular 
basis. 
 
To change the option you must be in the 'File and Save document' screen as shown on the previous page.  
Click the menu File and Save  and from the list choose Retain Index Folder  a tick will appear beside the 
option so that you will know if it is switched on.  
 
 
To File and Save Multiple Documents 
 
First you will need to select the document(s) you wish to file and save.  To access your Intray click the 

 button. To view documents within the Intray, click the text or grey image  in 
the Left-hand pane and the documents will be displayed as shown below: 
 

 
 

Click the first document required in the Middle pane then hold down the CTRL key and then click each 
subsequent document. 
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If you wish to highlight a group of documents click the first document then hold down the SHIFT key and click 
the last document in the Middle pane no matter what mode you are working in. 
 
Once the documents have been highlighted you are ready to File and Save: 
 

 If using the Simple mode click the  button in the Right-hand pane. 
 

 If using the Standard or Advanced mode click the  icon on the toolbar which appears at 
the top of the screen. 

 Using any of the three modes, right click one of the highlighted documents in the Middle pane and 
from the menu select the File and Save  option. 

 

 
 
No matter which method is used the 'File and Save Document' screen will be displayed as shown on the next 
page: 
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Each document selected will have a tab across the bottom of the 'File and Save Document' screen. 
 

 
 

File each document away as normal, for more information on file and save see page 65. The tab will 
disappear showing the next document to be filed and saved. Once the last document has been filed and 
saved the 'File and Save Document' screen will disappear. 
   
If you wish to file all the documents away using the same file and save information fill in the file and save 
pane. 
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Tick the Apply to all  check box and the following message will be displayed: 
 

 
 
Click the Yes button to continue with apply to all or click the No button to cancel. 
 
Once complete click the File and Save  button.  All documents will be filed and saved with the same 
information. 
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File and Reply to a Document 
 
The File and Reply feature will allow you to File and Save the document then create a new document to 
respond and when finished attach the response to the originally filed and saved document. 
 
Once the documents have been highlighted you are ready to File and Save: 
 

 If using the Simple mode click the  button in the Right-hand pane. 
 

 If using Standard or Advanced mode, click the  icon on the toolbar which appears at the 
top of the screen. 

 
 Using any of the three modes, right click the document in the Middle pane and from the menu select 

the File and Save  option. 
 

 
 
No matter which method is used the 'File and Save Document' screen will be displayed as shown below: 
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Once the file and save information is complete click the File and Reply  button and the 'Create' screen will be 
displayed: 
 

 
 
The ‘Documents ’ tab can create new documents (in many different file formats). 
 
To create the reply document first, type the Document Name  and click the drop down and choose the 
required File type . 
 
If a Template  is required when creating a document, click the drop down and choose a template from the 
list. If you want to create a blank document then leave the option <Use Default>  selected. 
 
Click the OK button and the document will be created in the chosen format. 
 
Enter the text into the document in the normal way then close and save the file.  The document will be 
brought into your Intray and the 'File and Save Document' screen will be displayed. 
 
File and Save the document as normal and click the File and Save  button.  The document saved will then be 
attached to the original document responded to. 
 

 
 
In the Standard or Advanced mode go to the Explore screen.  At any time after the document has been 
saved it can be re-filed and saved.  A small paper clip symbol will be displayed before the title of the 
document both on the original and the reply. 
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Re-File and Save a Document 
 
Re-File and Save is used to change the details after the initial File and Save.  Depending on the 'File and 
Save Documents' screen different actions can be performed. 
 
To re-file and save a document within Series 6 first find the document through the Explore  screen (for more 
information on explorer please see page 83) or the Search (for more information on Search please see page 
144) functions. 
 
In the Middle pane click the document to highlight then right mouse click the highlighted document. 
 

 
 
From the menu select the Re-File and Save  option and the 'File and Save Document' screen will be 
displayed as shown on the next page: 
 
When using the Re-File and Save  option depending on which type of the 'File and Save Documents' screen 
you have, will control what you can do in terms of re-file and save but moving from folder to folder.  The 
following pages will take you through the two screens and explain the options. 
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Re-File and Save in the Original File and Save screen Right-hand pane (default) 
 

 
 
You cannot change the Information type (Step 1) or the Standard Document (Step 3).  You are able to 
change the location as long as the Information Type is attached to other folders and also the Document 
References as long as they are not greyed out. 
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Re-File and Save using the Customised File and Save screen Right-hand pane 
 

 
 
You are able to change the location as long as the Information Type is attached to other folders (Index into), 
the Information Types, the Standard Documents and the Document References as long as they are not 
greyed out. 
  
No matter which 'File and Save Documents' screen you are using make the necessary changes to the File 
and Save information and then click the File and Save  button. 
 
 
Explore Documents 
 
Once a document has been filed away you may wish to browse them.  Explore is only available in the 
Standard and Advanced mode and only if the System Administrator has given the privileges to see it.   
 

To access the Workspace in the Standard mode click the  button on the floating toolbar or within the 

Advanced mode click the  button on the Left-hand pane. 
 
Click the white arrow  beside the Filing Cabinet option in the Left-hand pane to expand the 
folders underneath.   
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Click the white arrow beside the folder required in the Left-hand pane to expand the folders underneath. 
 
To open the content of the folder click title of the folder and the contents of the folder will be displayed in the 
Middle pane. 
 
To collapse the folders, click the black arrow beside any folder. 
 

 
 
In the Middle pane again click the white arrow beside the text to expand and to collapse click the black 
arrow. 
 

 
 
Click the file to view the summary within the Right-hand pane.   
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SCAN DOCUMENTS 
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INTRODUCTION TO SCAN A DOCUMENT 
 
Series 6 provides a very simple way of scanning documents into Invu within all three modes using something 
called Scanner Presets.  These are setup up by the System Administrator. 
 
Scan a Document in the Simple Mode 
 
Within the Simple mode you are able to scan basic black & white or colour documents.  To scan click the 
‘Scan ’ tab and the following screen will be displayed: 
 

 
 
To scan a document into Invu there are 3 steps 
 
Step 1: Choose the type of image to scan - click the option to scan in Black & White  or Colour .  If you 
have not got one of these preset configured for your scanner the following message may be displayed when 
you select one of them. 
 

 
 
You will need to click the OK button and contact your Series 6 Administrator. 
 
Step 2: Where do you want to send the scan - choose where the document should be placed after 
scanning.  Click the drop down list and choose from the available list of user or folder Intrays.  The default 
will always be My Intray (your own Intray). 
 
Step 3: Click the 'Scan' button to scan your docume nt and send it to the chosen Intray - Click the 
Scan  button to start scanning.  The document will be scanned and displayed in the preview area as shown 
on the next page.   
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The scanned document will be added to the chosen Intray.  If you have scanned it to your own Intray or an 
Intray you have access to you can view it.  To view a document which has been scanned, click the ‘My 
Work ’ tab and the screen will be displayed: 
 

 
 
In the Workspace  area select the Intray option in the Left-hand pane this will display all documents in the 
Middle pane. 
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To open, double click the selected document and the ‘View document’ screen will be displayed.  For more 
information on the 'View Document' screen please see page 116. 
 
 
Scan a Document in Standard and Advanced Mode 
 
When you want to scan documents in you are able to do so from the Explore , Search  and Workspace  

areas within Series 6.  Click the  icon on the toolbar and the following screen will be displayed. 
 

 
 
In the drop down called Select a preset to control the process  is a list of predefined scanning presets 
created by the System Administrator, such as scanning in black & white, colour, duplex (double sided) or 
even multiple page scanning.  Click the drop down arrow and from the list choose the required preset. The 
list will only display presets which have been setup for your type of scanner and if there is only one preset 
configured for your scanner then it will be selected automatically.   
 
Choose where the document will go once scanned in as follows: 
 

 Choose the Scan to my Intray  option to put the document into your own Intray. 
 

OR 
 

 Choose the Scan to the preset destination  option to put the document into the predefined Intray 
set within the scan preset you have chosen. 
 

OR 
 

 Choose the Scan to an Intray  option to put the document into a folder in an Intray selected from 
the drop down list.  If you wish to create a new folder to place the scanned document then tick the 
Create a new folder  check box in the selected Intray and the following screen will be displayed on 
the next page: 
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Enter a Folder name  and then click the OK button.  In the drop down the name of the folder will be 
displayed: 
 

 
 

 If you choose the File and Save the Scan immediately  option it will display the ‘File and Save’ 
screen to file and save the document straight away. 

 
If the document you are scanning is large you could scan it in two stages.  Tick the Prompt for additional 
page check box then scan the first part of the document, when the scanner has completed a message will be 
displayed asking for the next part of the document. 
 
To preview the document in the ‘Scan’ pane after scanning tick the Show pages after scanning  check box. 
 
When scanning a document in by default if the Scanned Document Title  field is left empty, a name will be 
assigned to each document scanned in.  This name is:  
 

ComputerNameYearMonthDay@Hoursminutesseconds 
 
For example: 
 

 
 
You can set the name for your scanned documents.  To do this, enter the required name into the Scanned  
Document Title  field as shown below: 

 
 

When the documents are scanned in it will attach four digits starting with 0001 and incrementing by one each 
document. 
 
Once scanning options have been chosen, click the Scan button. 
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When you access the ‘Scan’ screen again it will remember the setting you selected last time. 
 
You will need to go to the Workspace area to view scanned in documents.  In the Simple Mode the 
Workspace area is known as ‘My Work’.  Click the 'My Work ' tab to access the Workspace area.  To access 

the Workspace in the Standard Mode click the  button on the floating toolbar or if within the Advanced 

Mode click the  button on the Left-hand pane. 
 
Then click the Intray in the Left-hand pane to view documents.  To view, double click the selected document 
in the Middle pane and the ‘View document’ screen will be displayed.  For more information on the 'View 
Document' screen please see page 116. 
 

If you click the  icon and you have no presets which match your scanner the following will be 
displayed: 
 

 
 

Click the OK button to remove the message.  You will need to contact your Series 6 Administrator. 
 
 
Using Barcode Separators 
 
Series 6 has a barcode separator facility available for use with local scanners.  There is no Licences of 
Privileges required for this.  
 
There is no configuration for barcodes apart from to print out a barcode sheet, then place on at the front of 
the whole batch and then one in front of each new document in the batch.  The Scanner Preset must be 
configured for a minimum of 200 dpi , set to multiple pages  and Group 4 Tiff  file type.  If your preset is not 
setup correctly then contact your Series 6 Administrator. 
 
The Barcode sheet used can be obtained from the extranet or on the installation CD as shown on the next 
page: 
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OPEN DOCUMENTS 
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Open a Document 
 
You can open documents from your Intray , Explore  and Search . 
 
Browse to the document you wish to open then either: 

 
 Double click the required document in the Middle pane. 

 
OR 

 
 Right click the document in the Middle pane and from the menu select the Open option. 

 
OR 

 
 If using the Standard or Advanced Mode highlight the document in the Middle pane and click the 

 icon on the toolbar. 
 
The document will then open in a new window in the ‘View Document’ Screen: 
 

 
 
Within the 'View document' screen you are able to see the Summary and Notes in the Right pane and 
browse the document. 
 
NB:  For more information regarding the 'View Documents' screen please see page 116. 
 
If the document has multiple pages and is an image based document such as a Group 4 tiff then within the 
Right-hand pane a Thumbnails  option will appear. 
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Click the Thumbnails  option to see the following: 
 

 
 
Within the thumbnails area each page within the file will be displayed as a thumbnail.  To change the page, 
click on the appropriate thumbnail.  The thumbnail highlighted with a blue background is the current page. 
 
NB: Depending on how your system is configured, when you open certain documents they may open in the 
original software they were created in i.e. if you opened a Word document it could open in Microsoft Word. 
 
 
Once you have finished viewing the file, click X to close which appears in the top right corner of the ‘View 
Document’ screen. 
 
NB:  For more information regarding the 'View Documents' screen please see page 116. 
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Opening Multiple Documents 
 
You are able to open multiple documents in the ‘View Documents’ screen. 
 
To view multiple documents highlight the first document as normal, hold down the CTRL key and then click 
each subsequent document.   
 

 
 
Once all the required documents are selected do one of the following: 
 

 Hold the CTRL key and then right click the document in the Middle pane and from the menu select 
the Open option. 

 
OR 

 
 If using the Standard or Advanced mode highlight the document in the Middle pane and click the 

 icon on the toolbar. 
 
This will open the ‘View document’ screen and the selected documents’ title tabs will be shown along the 
bottom, enabling the user to quickly switch between them as shown on the next page. 
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The example shows the three documents open in the ‘View Document’ screen. One is a word document, a 
PDF and a Multiple page Tif. 
 
To identify which document is in focus the tab is highlighted orange.  To close any of the documents, simply 
click the  icon on the tab. 
 
NB:  For more information regarding the 'View Documents' screen please see page 116. 
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CREATE DOCUMENTS AND INFORMATION 
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INTRODUCTION TO CREATE A DOCUMENT 
 
Series 6 provides a very simple way in which to create new documents.  These could be MS Word, MS 
Excel, Text documents or many more (depending on the system’s configuration).  Creating a document can 
be done in all three modes. 
 
Create a Document in Simple Mode 
 
Click the ‘Create ’ tab and the following screen will be displayed. 
 

 
 
To create a document through Series 6 there are four steps as follows: 
 
Step 1: Please enter a title for your document  - Enter in the name of the document. 
 
Step 2: Choose the type of document from this list - Choose what type of document you would like to 
create.  Click the drop down list and choose the required file type i.e. Word Document. 
 
Step 3: If you would like to base your document on a Standard Document, select one from this list -  
If you would like to base your new document on an existing one, choose a template from the drop down list, 
if no special document template is required then select Default Template <Use Default> . 
 
Step 4: Click the 'Create' button to create your do cument  - Once you have completed the above steps, 
click the Create button.  Series 6 will create the document in the chosen format. 
 
The new document will be opened in its native application, when finished adding the content Close and Save 
the document.  The document will then be saved into your Intray and the 'File And Save Document' screen 
will be displayed.  File and Save the document as normal (for more information please see page 65). 
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Create a Document in Standard and Advanced Mode 
 
You can create a document from the Workspace, Explore or Search.  On the toolbar click the arrow to the 

right of the  button and choose the Documents…  option.  The following screen will be displayed as 
shown below. 
 

 
 
The ‘Documents ’ tab allows you to create new documents (in many different file formats). 
 
To create a new document first, type the Document Name . 
 
Choose a File type  for the document that will be created.  Click the drop down list and choose the required 
file type.  
 
NB:  This may vary depending on what has been setup by the System Administrator. 
 
If you would like to base the document you create on an existing document you will need to choose a 
Template , click the drop down list and select from the available options.  If the user wished to create a blank 
document then leave the <Use Default>  selected. 
 
Click the OK button and the document will be created in the chosen format. The new document will be 
opened in its native application, when finished close and save the document and application, if applicable; it 
will then be saved into your Intray in Series 6.  The document can now be filed and saved (for more 
information please see page 65). 
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Create Information Only in Standard and Advanced Mo de 
 
You can also create and file information such as details of a enquiry by phone.  Click the arrow to the right of 

the  button and choose the Information only… option. The following screen will be displayed: 
 

 
 
The 'Information Only ' tab is where you can add information in note form.  The area to the left is a free text 
and you can also copy and paste text from other sources if required. 
 
Also basic formatting options are available via the toolbar along the top, such as inserting text and images, 
font formatting, alignment, bullets and the option to undo/redo. 
 

 
 
Once the text has been entered and formatted on the Right-hand side of the screen the File and Save pane 
there are four steps to file and save the information away. 
 
Step 1: Choose what sort of document it is? - Here you would choose the Information Type (category).  
This could be Marketing Materials, Training Documents, and Product Documents etc…Click the drop down 
list and choose required Information Type. 
 
Step 2: Choose a filing location - This is determined by what Information Type has been selected in the 
previous tab.  Click the white arrow to expand a folder and the black arrow to collapse a folder.  When you 
have found the folder, click the text to highlight in blue. 
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Step 3: Choose a Standard Document for the document  - This is determined by what Information Type 
has been selected in Step 1.  If there is only one Standard Document then it will automatically be selected.  
Click the drop down list and choose the required Standard Document. 
 
Step 4: Enter the Document Reference information - Once a Standard Document has been chosen, the 
Document References will be displayed (this can vary based upon the standard document).  
 
Once the information has been entered click the OK button and the following dialogue box will be displayed: 
 

 
 
The title will normally come from the first line of text entered but if required you overwrite this with a more 
suitable title.  Click the OK button to continue. 
 
The Information (text) entered would then be created as an XML file and filed and saved into the chosen 

location.  This can be viewed in the ‘Explore ’ tab.  To access the Explore in the Standard mode click the   

button on the floating toolbar or within the Advanced mode click the  button on the Left-
hand pane. 
 

 
 
In the above picture is an example of what Information Only looks like when filed away.  
  
NB: You cannot create and file Information only in the Simple mode. 
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Create an Email in Standard and Advanced Mode 
 

You can also create and send emails.  Click the arrow to the right of  button and choose the 
Email… option.  The following screen will be displayed: 
 

 
 
A blank email screen will be displayed.  Enter the email details as normal then send the email. 
 
NB: You cannot create and send emails within the Simple mode. 
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Deleting a Document 
 
Any document can be deleted from Series 6 depending on the rights defined by the System Administrator.   
 
You can delete documents from Workspace, Explore and Search.  To delete documents, right click the 
selected document in the Middle pane.   
 
If you wish to delete multiple documents then highlight the first document then hold down the CTRL key and 
click each subsequent document.  If the documents you wish to delete are in a block then highlight the first 
document then hold down the SHIFT key then click the last document in the block. 
 
With multiple documents highlighted hold down the SHIFT or CTRL key when you right click otherwise the 
documents will deselect. 
 
From the right click menu select the Delete  option, if the document you wish to delete has more than one 
version the following will be displayed: 
 

 
 
The Delete all versions  option, if selected, will delete all versions of the documents.  For example if you 
deleted version 1 but also version 2 and 3 existed they would be deleted too.  
 
The Delete selected versions only  option, if selected, will delete only the selected documents so if other 
versions exist they will not be deleted. 
 
Once an Action has been selected, click the OK button to continue.  The following will be displayed: 
 

 
 
Click the Yes button to confirm deletion.  Click the No button to stop deletion.  Once the document has been 
deleted it cannot be retrieved.  
 
If the document you wish to delete has only one version the following will be displayed: 
 

 
 
Click the Yes button to confirm deletion.  Click the No button to stop deletion.  Once the document has been 
deleted it can be retrieved but only by your Systems Administrator.  
 
NB:  The action of deleting a document is audited, even though the document no longer exists in the 
folder/Intray. 



 
 

  
Invu Services Limited © 2009 

Page 107 of 221 
End User Manual V 6.2.3 

 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
EDITING DOCUMENTS 
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INTRODUCTION TO EDITING DOCUMENTS 
 
Editing a document in Series 6 allows you to make changes.  This can be done in any mode. You can edit 
documents which sit in your own Intray and also in Explore and Search but it does depend on your security 
set by the System Administrator. 
 
When a document is edited Series 6 will automatically check out the document which means you will have 
exclusive access to make changes.  However, other users are still able to search and view the document. 
 
All users within Series 6 will immediately notice if a document has been checked out as it will appear in red 
text.  All documents that are checked out will be listed in the area called ‘Current Documents’ within 
Workspace (for the user who has it checked out).  
 
 
Edit a Document 
 
To edit a document, right click the required document in the Middle pane and from the right click menu select 

the Edit option or if using the Standard/Advanced mode click the  button on the main toolbar. 
 
The document will be opened in its native application or the Invu Viewer depending on the document and the 
systems configuration.  Changes can then be made as normal.   
 
NB:  If you edit an image based document such as a .tif it will open in the 'Edit Document' screen for more 
information on using this screen please see page 211. 
 
Once the changes have been made the document should be closed and saved.  The following message will 
then be displayed: 
 

 
 
Click the No button to leave the document checked out this can then be checked in at a later date. 
 
OR 
 
Click the Yes button to check in the document.  For information on how to check in a document go to page 
109. 
 
NB:  If editing a document which is not the latest version please see Version and Check Out 
on page 109.  
 
 
To Check Out a Document 
 
If the document is to be worked on later or in 'offline' mode the Check out option can be used so that you can 
make the changes at your leisure.  It will also allow you to work on the document when not connected to 
Series 6. 
 
You can Check In  documents from your Intray and current documents in Workspace, in Explore and Search 
but it does depend on your security set by the System Administrator. 
 
When a document is checked out it will give you exclusive access to edit the document.  While the document 
is checked out other users can not edit or check out this document.   
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However users on the system are still able to search and view the document, although they will not see the 
changes made to the document until it has been checked in again. 
 
The document will be shown in red text and also be added to Current Documents in the Workspace. 
 
To check out a document, in the Middle pane right click the selected document.  From the right click menu 
select the Check out  option.  If using the Standard or Advanced mode highlight the document in the Middle 
pane and then click the  button on the toolbar. 
 
When you check out a document it will be displayed in red text where ever it is located. 
 

 
 
You can also see which documents you currently have checked out as they will be listed in the area ‘Current 
Documents’ within Workspace. 
 
In the Simple Mode the Workspace area is known as ‘My Work’.  Click the 'My Work ' tab to access the 

Workspace area.  To access the Workspace in the Standard Mode click the  button on the floating toolbar 

or if within the Advanced mode click the  button on the Left-hand pane.  Then click the 
 option and the documents will be displayed: 

 

 
 
To edit a document that has been checked out.  In  area, right click the document and from 
the right click menu choose the Edit  option.  If using the Standard or Advanced mode, highlight the 

document and click the  button on the main toolbar.  The document will be opened in its native 
application. 
 
Changes can be made as normal; close and save the document when finished.  
 
Version and Check Out 
 
NB:  If editing a document which is not the latest version i.e. if current version is 2 but the version being 
edited is 1 it will display a message as shown on the next page: 
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Because the document is not the current version the system will only allow you to create a copy which will be 
placed in your Intray and version will start from 1.  Click the Yes button to create a copy.  Click the No button 
to abort edit. 
 
If a document is displayed in green text this is a draft document. 
 

 
 
You can edit a draft as long as it is the current version, if you edit a draft document and the following 
message is displayed: 
 

 
 
This would be because the draft is not the latest version the user is not able to check it out. Click the OK 
button to clear the message. 
 
 
To Check in a Document 
 
When a document has been Checked Out or Edited it needs to be Checked In. The changes made will then 
become public. 
 
To access your checked out document, in the Simple mode the Workspace area is known as ‘My Work’.  
Click the 'My Work ' tab to access the Workspace area.  To access the Workspace in the Standard mode 

click the  button on the floating toolbar or if within the Advanced mode click the  
button on the Left-hand pane.  Then click the  option and the documents will be 
displayed as shown on the next page: 
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In the Middle pane right click the document and from the right click menu choose the Check In  option.  If 

using the Standard or Advanced mode click the  button on the main toolbar and the following screen 
will be displayed: 
 

 
 
The 'Check In' screen allows you to specify the type of revision made to the document. 
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In the Action  area choose from one of the following options: 
 
New version  – if selected creates a new version of the document.  I.e. if the version number was 1 this will 
increment to 2.  of if the version number was 2.4 then the new version would be 3. 
 
New draft – if selected creates a draft (meaning the document is a work in progress not the finished 
revision). The draft number will be based on the version created from and increment by .1.  I.e. if the version 
was 1 then draft would be 1.1 or if created from an existing draft 1.3 then new draft would be 1.4.  The 
document will be displayed in green text. 
 
In the Description  area, type brief notes of what was done to the document. This is for other users to review 
the comments made when checking in the revision. 
 

 
 
The notes entered can have basic font and paragraph formatting applied using the toolbar above the notes 
area. 
 
Click the OK button to check the selected document back in. 
 
This will remove the document from the  area and the text will revert back to black (or 
green if a draft).  The new version/draft number will be displayed in the version column in the Middle pane. 
 
NB:  The system will by default only show the current version. For information on how to view other versions 
of a document please see page 42. 
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Drag 'n' Drop Check in 
 
A new version or draft can be checked in by dragging over the version stored in Series 6 as long as it is the 
same type of document. 
 
Move the mouse pointer over the document which you wish to check in as the new version. 
 

 
 
Hold down the left mouse button and drag the document into Series 6 and over the document it should be 
the new version of (the mouse pointer should have a plus symbol) and then release the mouse button and 
the 'Check In' screen will be displayed. 
 
In the Action  area choose from one of the following options: 
 
New version  – if selected creates a new version of the document.  I.e. if version number was 1 this will 
increment to 2 or if the version number was 2.4 then the new version would be 3. 
 
New draft – if selected creates a draft (meaning the document is a work in progress not the finished 
revision). The draft number will be based on the version created from and increment by .1.  I.e. if version was 
1 then draft would be 1.1 or if created from an existing draft 1.3 then new draft would be 1.4.  The document 
will be displayed in green text. 
 
In the Description  area, type brief notes of what was done to the document. This is for other users to review 
the comments made when checking in the revision. 
 
NB:  If performing a  ‘Drag and Drop’ check in make sure the document you are dragging the new copy over 
is not checked out other wise the feature will not work. 
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The notes entered can have basic font and paragraph formatting applied using the toolbar above the notes 
area. 
 
Click the OK button to check the selected document back in. 
 
This will remove the document from the  area and the text will revert back to black (or 
green if a draft).  The new version/draft number will be displayed in the version column in the Middle pane. 
 
NB:  The system will by default only show the current version.  For information on how to view other versions 
of a document please see page 42. 
 
 
Undo Check Out 
 
When a document is checked out the normal process to place it back into the Filing Cabinet would be to 
check the document back in.  In some cases the user may wish to ‘revert’ the checked out document back to 
the version before it was checked out, this is known as Undo Checkout . 
 
When the Undo Check out option is selected it will revert to the version prior to being checked out and all 
changes to the document will be lost. 
 
To undo a checked out document, first access your check out document, in the Simple mode the Workspace 
area is known as ‘My Work’.  Click the 'My Work ' tab to access the Workspace area.  To access the 

Workspace in the Standard mode click the  button on the floating toolbar or if within the Advanced mode 

click the  button on the Left-hand pane.  Then click the  option and the 
documents will be displayed. 
 
In the Middle pane right click the selected document and from the menu select the Undo Checkout  option. 
 
This will remove the document from the  area and the text will change back to black (or 
green if a draft). 
 
NB:  If a document has been checked out by another user and you wish to undo the check out on that then 
as long as you have the correct privilege then you are able to undo check out for other user documents. 
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THE VIEW DOCUMENT SCREEN 
 
Once a document has been opened the 'View document' screen is displayed.  Here you are able to use 
certain tools to view the document in a better way.   (For more information on opening documents please see 
page 74.) 
 
It enables the user to see the contents of a selected document and also the Right-hand pane which will 
display summary details (Document References) if filing and saving a document in the File and Save Pane. 
 
Depending on the type of file open other toolbars may also be displayed.  If opening a office or PDF 
document toolbars from the native application are displayed and the functionality of the View document 
screen are greatly reduced.  Below is an example of a word and PDF document. 
 

 
An open word document 
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An open PDF document 
 
When working with Office and PDF documents there are only four options available: 
 

 File - Print  - you are able to print documents out (see page 120). 
 File - Close  – will close the View screen 
 File and Save – File and Save  the document  
 Help - Contents  - view the help for Series 6 
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If working with image based documents such as jpg or .tif then full functionality is available within the 'View 
Documents' screen as shown below: 
 

 
 
In the following sections the menus and icons are explained. 
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The File Menu 
 
You can print out documents from Series 6.  The print options are found in the File  menu. 
 
Print Preview 
 
To preview the image based document before printing, in the 'View Documents' screen click the File  menu 
and then select the Print Preview  option so the 'Print ' screen will be displayed.  Click the OK button and the 
'Print Preview' screen will be displayed. 
 

 
 
Here you can zoom in and out and browse multiple pages using the toolbar.  Click the Close  button to exit 
the screen. 
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Print Options 
 
To change the print options before printing, in the 'View Documents' screen click the File  menu and then 
select the Print Options  option and the following screen will be displayed.   
 

 
 

The Actual size  option will make sure that when the document is printed it will print in full size no matter how 
many pages it will span. 
 
The Fit to page  option will ensure that each page fits to the paper size chosen. 
 
Click the OK button to save the changes. 
 
Print 
 
Choose the File  menu then select the Print  option and the screen on the following page will be displayed: 
 

 
 
Choose appropriate options and then click the OK button to print. 
 
Send - Pages by Email 
 
You are able to send selected pages as an attachment on an email using the Thumbnails pane within the 
'View documents' screen. 
 
To send selected pages by email, open a document. 
 
If a one page document then click the File  menu then select the Send and then click the Pages by Email  
option.   
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If the document has multiple pages on the Right-hand pane at the bottom the button will be displayed.  Click 

the  button, the Right-hand pane will change to show mini images of each page in that 
document. 
 

 
 
Click the thumbnail you wish to attach or if you wish to select multiple pages click the first then hold down the 
CTRL key and click each subsequent thumbnail. If the thumbnails you wish to select are in a block then click 
the first thumbnail then hold down the SHIFT key and click the last thumbnail in the block. 
 
Once the thumbnails are highlighted, click the File  menu and then select the Send Pages by Email  option.   
 
No matter whether a single page or multiple pages selected, the email screen will be displayed with the 
document attached.   
 

 
 
 
If you have selected multiple pages these will be placed in one file and attached.  Complete the email as 
normal and click the Send button. 
 
Close 
 
If you wish to exit the ‘View Document’ screen click the File  menu and then select the Close  option. 
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The Edit Menu 
 
The Edit menu will allow you to edit the existing document you have open in the viewer or if you have 

multiple documents the current one.  Select the Edit  menu then Current Document  option or click the  
Icon and the ‘Edit Document’ screen will be displayed: 
 

 
 
Once you have made the changes click the X in the top right corner and the following message will be 
displayed: 
 

 
 
Click the Yes button to save the changes and check the document in as normal.  For information on how to 
check in please see page 109. 
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Tools Menu 
 
The Tools  menu will allow to you manipulate the view of the document by using Zoom. Centre and magnify 
tools. 
 
None 
 
Click the File  menu and then select the None option, a tick will be displayed by the option and this will turn of 
the three other options Zoom , Centre  and Magnifying Glass . 
 
Zoom 
 
This is the default option.  Click the File  menu and then select the Zoom option, a tick will be displayed by 
the option.   
 
Move the mouse to where you would like to zoom in. 
 

 
 
Click and drag a box like the one shown in the picture above and when you release your mouse it will zoom 
in. 
 
Centre 
 
Click the File  menu and then select the Centre option, a tick will be displayed by the option.   
 
Move your mouse into the document where you would like to centre it click once and the point will be 
centred. 
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Magnifying Glass  
 
This is the default option.  Click the File  menu and then select the Magnifying Glass option, a tick will be 

displayed by the option or click the  icon on the toolbar. 
 
Move your mouse into the document then hold down the mouse and where ever your mouse is will be 
magnified in a box as shown below.  While you are hold down the mouse button you can also move your 
mouse around the document to view other areas. 
 

 
 
Once you release your mouse it will go back to the default tool Zoom . 

 
 
View Menu 
 
In the View menu you can use zoom tools and navigation tools which can be very useful.  The view option 
can also be found on the toolbar as well. 
 

 
 

 Zoom in  
The user can easily zoom in on a document’s content.  Each time the icon is clicked it will zoom in further or 
click the View menu then select the Zoom  option and click In. 
 

 Zoom out  
The user can easily zoom out from document’s content.  Each time the icon is clicked it will zoom out further 
or click the View menu then select the Zoom  option and click Out 
 
The Normal Fit  option when selected will show the document at 100%.  To use click the View menu then 
select the Zoom  option and then click Normal Fit . 
 

 Fit to window 
The document will fit to the window for better viewing if clicked or click the View menu then select the Zoom  
option and then choose the Fit to window  option. 
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 Fit to Width  
The document will fit to the width of the viewer to get a closer look if clicked or click the View menu select the 
Zoom  option and then select the Fit to width  option. 
 

 Navigation  
These icons enable the user to navigate through multiple page documents.  The First Page, Pervious Page, 
Next Page and Last Page as well as the option to choose a specific page number.  To navigate via the menu 
click the View menu then select the Page option and then choose from the First Page , Previous Page , 
Next Page  and Last Page  options.  
 

 Show Annotations 
This will show any annotation added to image based documents if clicked or click the View menu then select 
the Show Annotations .  Click the icon again or the menu option to turn it off. 
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View Options 
The view options will allow you to change how things are viewed.  Click the View menu and then select the 
Options  option.  The screen on the following page will be displayed: 
 

 
 
The Always show annotations  check box, if ticked, will always show annotations by default. 
 

The default annotation font can be changed.  To change the font click the   and the following screen will 
be displayed as shown below: 
 

 
 
Make the necessary changes to the font then click the OK button to return back to the view options. 
 

You can also change the default colour of the annotation text, Click the  button and a drop down 
will be displayed on the next page: 
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Choose the colour required and the button will change to that colour. 
 
  
Image Menu Options 
 
Within the image menu you are able to rotate the images and also tidy up so that you can read it better.   
 
Click the Image menu and then select the Rotate  option, a cascade menu will be displayed: 
 

 
 
Here you can choose the degrees you wish to rotate  the image or flip  the document horizontally  or 
vertically . 
 

There is also a toolbar which has the same options . 
 
Click the Image menu and then select the Filter  option and the following menu is displayed: 
 

 
 
Despeckle 
This option will clean the image and eradicate any grey blemishes from the body of the document.  
 
Deskew 
The image will be straightened automatically after scanning. 
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Border removal 
Will remove Borders from the document.  
 
Dot Removal 
Will remove any dots from the document 
 
Holepunch removal 
Will remove any hole punch marks from the document. 
 
Line Removal   
Will remove unnecessary lines from the document.   
 
  
File and Save Menu Options 
 
Within the File and Save menu you are able to take the current document and file it away.  Click the File and 

Save Menu then select the File and Save  option or click the File and Save Current Document   icon 
and the following will be displayed: 
 

 
 

File the document in the normal way for more information on file and save see page 65. 
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Help Menu 
 
Click the Help  menu and then select the Contents  option and the help for Series 6 will be displayed: 
 

 
 
Use the Left hand panel to expand the topics and click the page to view the contents.   
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THE EDIT DOCUMENT SCREEN 
 
When you edit a document depending on the type of document and how the system has been configured 
you may see the 'Edit Document' screen.  The 'Edit document' screen is normally only used for image based 
documents such as tiff, jpg, bmp images. 
 
To access the 'Edit Document' screen you will need to edit a document.  For more information on editing 
please see page 108.   
 

 
 
The functions within the 'Edit Document' screen  are used to change the document such as moving the page 
around, removing pages, image tools such as rotating and also annotating the document as well. 
 
In the section on the next page the options are explained: 
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File Menu 
 
Print Preview 
 
To preview the document click the File  menu then select the option Print Preview  and the print screen will 
be displayed.  Click the OK button and the Print Preview screen will be displayed. 
 

 
 
Click the Close  button to exit the screen. 
 
Print Option 
 
To change the print options before printing, in the 'View Documents' screen click the File  menu and then 
select the Print Options  option and the following screen will be displayed.   
 

 
 

The Actual size  option will make sure that when the document is printed it will print in full size no matter how 
many pages it will span. 
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The Fit to page  option will ensure that each page fits to the paper size chosen. 
 
Click the OK button to save the changes. 
 
Print  
 
Choose the File  menu then select the Print  option and the following screen will be displayed: 
 

 
 
 
Choose appropriate options then click the OK button to print. 
 
Send – Pages to Intray 
 
When working with a document you are able to send selected pages to your Intray using the Thumbnails  
pane within the 'Edit documents' screen. 
 
To send selected pages to your Intray, Edit a document. 
 
If a one page document, click the File  menu and then select the Pages to Intray  option.   
 
If the document you are editing has multiple pages then on the Right-hand pane at the bottom the 

 button will be displayed.  Click the  button, the Right-hand pane will change to show 
mini images of each page in that document. 
 

 
 
Click the thumbnail you want to send to your Intray or if you wish to select multiple pages click the first then 
hold down the CTRL key and click each subsequent thumbnail. If the thumbnails you wish to select are in a 
block then click the first thumbnail then hold down the SHIFT key and click the last thumbnail in the block. 
 
Once the thumbnails are highlighted, click the File  menu then click Send and then select the Pages to 
Intray  option.   



 
 

  
Invu Services Limited © 2009 

Page 133 of 221 
End User Manual V 6.2.3 

 

The document will be sent straight to your Intray as a copy it is not linked in any way to the original. 
 
Close 
 
If you wish to exit the ‘Edit Document’ screen click the File  menu then select the Close  option. 
 
 
Tools Menu 
 
The Tools  menu will allow to you manipulate the view of the document by using Zoom. Centre and magnify 
tools. 
 
None 
 
Click the File  menu and then select the None option, a tick will be displayed by the option and this will turn of 
the three other options Zoom , Centre  and Magnifying Glass . 
 
Zoom 
 
This is the default option.  Click the File  menu and then select the Zoom option, a tick will be displayed by 
the option.   
 
Move the mouse to where you would like to zoom in. 
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Click and drag a box like the one shown in the picture above and when you release your mouse it will zoom 
in. 
 
Centre 
 
Click the File  menu and then select the Centre option, a tick will be displayed by the option.   
 
Move your mouse into the document where you would like to centre it click once and the point will be 
centred. 
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Magnifying Glass  
 
This is the default option.  Click the File  menu and then select the Magnifying Glass option, a tick will be 

displayed by the option or click the  icon on the toolbar. 
 
Move your mouse into the document then hold down the mouse and where ever your mouse is will be 
magnified in a box as shown below.  While you are hold down the mouse button you can also move your 
mouse around the document to view other areas. 
 

 
 
Once you release your mouse it will go back to the default tool Zoom . 

 
 
Page Menu 
 
When editing a document an option is available that will allow you to manipulate the pages of a document.   
 
Click the Page menu and the following options are available: 
 

 
 
The above options will allow you to reposition pages if they have been scanned in wrong or even remove 
pages. 
 

If the document you are editing has multiple pages on the Right-hand pane at the bottom the  

button will be displayed.  Click the  button, the Right-hand pane will change to show mini images 
of each page in that document. 
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In the Thumbnails  pane click the thumbnail you wish to delete or move. 
 
Delete option to delete the current page selected. 
 
Select the Move up  option to move the selected page up by 1 page.  I.e. if current page was Page 3 and 
choose Move up  then it would become Page 2.  
 
Select the Move Down  option to move the selected page down by 1 page.  I.e. if current page was Page 3 
and choose Move Down  then it would become Page 4.  
  
Select the Move to first page  option to move the selected page to be the first page of document. Select the 
Move to last page  option to move the selected page to be the last page of the document. 
 
You can also add pages to an existing document.  To add a new page, click the Page menu and select the 
Add Page  option.  The following screen will be displayed: 
 

 
 
Click the drop down list and choose a preset  and then click the Scan button it will bring in the pages that 
have been scanned.  The scanned pages will be added after the last page of the document. 
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When finished making the changes to the document, click the File  menu and select the Exit  option. The 
following screen will be displayed if changes have been made: 
 

 
 
Click the Yes button to save any changes you have made and exit.  Click the No button to abandon any 
changes made and exit. 
 
You can also use these pages option on the Page Toolbar. 
 

 
 
 
View Menu 
 
In the View menu you can use zoom tools and navigation tools to move around the document.   
 

 
 
These option can be found on a toolbar as well. 
 

 
 
Zoom 
 

 Zoom in  
The user can easily zoom in on a document’s content.  Each time the icon is clicked it will zoom in further or 
click the View menu then Zoom  and click In. 
 

 Zoom out  
The user can easily zoom out from document’s content.  Each time the icon is clicked it will zoom out further 
or click the View menu then Zoom  and click Out 
 

 Fit to window 
The document will fit to the window for better viewing or click the View menu then Zoom  then select the 
option Fit to window . 
 

 Fit to Width  



 
 

  
Invu Services Limited © 2009 

Page 138 of 221 
End User Manual V 6.2.3 

 

The document will fit to the width of the viewer to get a closer look or click the View menu then Zoom  then 
select the option Fit to width . 
 
Page 
 

 Navigation  
These icons enable the user to navigate through multiple page documents.  The First Page, Pervious Page, 
Next Page and Last Page as well as the option to select a specific page number.  To navigate via the menus 
click the View menu then the Page then choose from First Page , Pervious Page , Next Page  and Last 
Page options.  
 

 Magnifying Glass 
 
Is on the Toolbar and in the Tools  menu. See page 135. 
 
Show Annotations 

When editing a document click the  icon or click the View menu and choose Show annotations  to 
display the annotation toolbar at the bottom of the screen (as shown below) and show any annotation 
already added to the document.   
 

 
 
This toolbar consists of drawing, text, notes, ruler's, buttons, hyperlinks and even audio tools. 
 

For example the Rubber Stamp  icon will display text such as Urgent, Action, and Approved etc.  To 
apply a stamp, click the arrow to the right of the Rubber Stamp  icon.  From the menu choose the type of 
stamp to apply such as Approved.   
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Move the mouse into the document.  Click and drag and the stamp will appear as shown above. 
Options 
 
The view options will allow you to change how things are viewed.  Click the View menu and then select the 
Options  option.  The screen on the following page will be displayed: 
 

 
 
The Always show annotations  check box, if ticked, will always show annotations by default. 
 

The default annotation font can be changed.  To change the font click the   and the following screen will 
be displayed as shown below: 
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Make the necessary changes to the font then click the OK button to return back to the view options. 
 

You can also change the default colour of the annotation text, Click the  button and a drop down 
will be displayed on the next page: 
 

 
 
Choose the colour required and the button will change to that colour. 
 
 
Image Menu 
 
Within the image menu you are able to rotate the images and also tidy up so that you can read it better.   
 
Rotate 
 
Click the Image menu and then select the Rotate  option, a cascade menu will be displayed: 
 

 
 
Here you can choose the degrees you wish to rotate  the image or flip  the document horizontally  or 
vertically . 
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There is also a toolbar which has the same options . 
 
Filter 
 
Click the Image menu and then select the Filter  option and the following menu is displayed: 
 

 
 
Despeckle 
This option will clean the image and eradicate any grey blemishes from the body of the document.  
 
Deskew 
The image will be straightened automatically after scanning. 
 
Border removal 
Will remove Borders from the document.  
 
Dot Removal 
Will remove any dots from the document 
 
Holepunch removal 
Will remove any hole punch marks from the documents. 
 
Line Removal   
Will remove unnecessary lines from the document.   
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Help Menu 
 
Click the Help  menu and then select the Contents option and the help for Series 6 will be displayed: 
 

 
 
Use the Left hand panel to expand the topics and click the page to view the contents.   
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SEARCHING 
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SEARCHING  
 
Invu Series 6 provides a great deal of flexibility in the way in which the user can perform a search within the 
system.  A general search in the Simple Mode will always search through both the document’s filing 
information and its content.  When performing a search within the Simple mode all locations are searched 
including the Intrays accessible by the user.  Within the Standard and Advanced mode when you perform a 
search you are able to choose, where, and what information is searched such as document content or the 
document references (metadata) and even search for a document with specific document reference values. 
 
Simple Mode Search 
 

 
 
To search for a document within the Simple Mode click the ‘Search ’ tab and then enter the word or phrase 
into the field called Please enter your search .  Press the Enter key or click the Search  button to activate the 
search.  The matching documents will be displayed in the search results area as shown on the next page: 
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If you wish to run another search remove text from the Please enter your search  field, enter the new search 
text and press the Enter key or click the Search  button new search results will be displayed. 
 
Standard and Advanced Mode Search 
 
In the Standard and Advanced modes there is scope to search through either the document’s filing 
information or content, or to build more complex searches by using logic and filters.  The search can also be 
localised to specific locations within the Invu system (such as a specific Folder or Filing Cabinet) to narrow 
the search’s scope. 
 

To access Search, in the Standard Mode click the  button on the floating toolbar or if within the Advanced 

mode click the  button on the Left-hand pane. 
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In the Left-hand pane is the search area here you would enter the 
criteria for the search, this pane is split into two sections – Search 
within  and Search for .   
 
The ‘Search within’ area – controls where within the Series 6 the 
search needs to take place. 
   
The ‘Search For’  area – specifies the criteria used to find the 
documents. 
 
Two different types of Searches can be performed: 
 
Text Search  – enables the user to search through all Document 
References and the contents of the documents (this is the default 
search option). 
 
Document References Search  – enables the user to create more 
complex criteria using specific Document References incorporating logic 
and operators.   
 
Text Search 
 
A text search can search through the metadata and/or the contents of 
the documents within Series 6.   
 
 
To perform a Text search, First choose where you are going to search.    
In the area 'Search within'  click All  to search all Intrays and folders you 
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have access to.  To search all Intrays click the  option so it is highlighted in blue.   To search a 

specific Intray click the white arrow beside the  option then click the name of the Intray you wish to 
search so it is highlighted in blue. 
To search all filing cabinets click the  option.  To search a specific folder click the white 
arrow beside  option then browse to the folder.  Click to highlight in blue. 
 
Next you need to enter the search text.  Type in a word or phrase to base the search on into the Search for  
text box.   
 
Then tick the Search metadata  check box to search through all Document References and/or tick the 
Search content  check box to search through the documents’ content.  Ticking both check boxes will ensure 
both Document References and document content is searched.  
 
When performing a text search there are several Options  to widen the search for documents.   
 

 Stemming  
 Phonic  
 WordNet Synonyms  
 WordNet related synonyms  
 Fuzzy 

 
 
To view these options click the white arrow beside the  heading.   The available option will be 
displayed as shown below. 

 
 
Stemming 
Tick to extend the search to check for grammatical variations on a word i.e. a search for ‘applied’  would also 
find documents with ‘applying’, ‘applies’, and ‘apply’. 
 
Stemming searches can also be applied across all text in the search criteria, by appending the special 
character of ~ at the end of specific words i.e. applied~ . 
 
Phonic  
Tick to extend the search to check for words which sound like and begin with the first letter of the search 
phrase i.e. a search for ‘Smith’  would also find ‘Smite’, ‘Smyth’, ‘Smithy’ etc. 
 

Phonic searches can also be applied, by placing the special character of # in front of the word in the search 
criteria i.e. #smith  
 
WordNet ® & WordNet® related Synonyms 
These options will extend the search to check for words with a similar or related meaning using a thesaurus. 
  
WordNet® synonyms - If ticked will search through a comprehensive thesaurus. I.e. if a search for 'fast'  was 
initiated it would also look for  'quick', 'speedy', 'rapid', 'express' etc. 
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WordNet® related Synonyms - If ticked will search for related words in the thesaurus.  I.e. if a search for 
'fast' was initiated it would look for 'quick', 'speedy', 'rapid', 'express' and related words such as 'slow', 
‘velocity’, ‘accelerates’, etc. 
 

Synonym searches can also be applied by appending the special character & at the end of certain words in 
the search criteria.  I.e. improve&  
 
Fuzzy 
 
Tick to extend the search to check for words, even if they are misspelled.  A degree of fuzziness can be 
applied from 1 to 10 .i.e. a fuzzy search for 'chosen'  will find 'chosen' with the degree of fuzziness set to 2.  
The higher the degree the more search results will be returned.  
 
Fuzzy searching can be useful when searching text that may contain typographical errors, or for text that has  
been scanned using optical character recognition (OCR). 
 
A search for alphabet  with a fuzziness of 2 would find alphaqet , with a fuzziness of 3 it would find both 
alphaqet  and alpkaqet . 
 
Fuzziness is not built into the index, so you can vary fuzziness at the time of each search. 

You can also add fuzziness selectively by using the % character. The number of % characters you add 
determines the number of differences the search engine will ignore when searching for a word. The position 
of the % characters determines how many letters at the start of the word have to match exactly. Examples:  
 
fav%our  Word must begin with fa and have at most one difference between it and favour.  
 
fav%%our Word must begin with fav and have at most two differences between it and favour 
 
Other Special Characters 
 
The special character can be applied to match any characters within the search criteria. 
 

The ? special character would be used to replace a letter. I.e. M?N would look for Man, Men or Min. 
 

The * special character would be used to search for documents were the search value starts with or ends 
with. I.e fav*  would find anything which starts with fav.   
 

The and special character would be used to search for more than one word in the same document but not 
a phrase.  I.e.  Administration and Support  would find any document with both those words. 
 

The or special character would be used to search for different words in the documents.  I.e. storage or 
cabinets would find any documents which contain the word Storage or cabinets in the contents or Document 
References. 
 
NB:  The special characters can also be used in the Simple mode. 
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Once the search criteria has been set click the  button and the results will be displayed in the 
Middle pane.  Series 6 will display the total number of results in the title of the Middle pane. 
 

 
 
Depending on the number of results returned it may not see the documents but instead see the section 
headings (Information Types and Standard Documents). 
 
To expand all results, right click anywhere in the Middle pane. 
 

 
 
From the right click menu select the View option then click Expand all sections . 
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These documents can be worked with in the normal way such as open, edit etc… 
 

To clear a search and results from the Middle pane click the  button in the Left-hand pane. 
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Document References Search 
 
A Document Reference search will search for a document using specified references and also enable you to 
create more complex searches using operators. 
 

To open the Document Reference search feature click the  button to clear the current search then click 

the  button. 
 

To perform a document reference search, first choose where you are 
going to search.  In the area 'Search within'  click the All  option to 
search all Intrays and folders you have access to.  To search all Intrays 

click the  option so it is highlighted in blue.   To search a 

specific Intray click the white arrow beside the  option then 
click the name of the Intray you wish to search so it is highlighted in 
blue. 
To search all filing cabinets click the  option.  To 
search a specific folder click the white arrow beside  
option then browse to the folder click to highlight in blue. 
 

 
 

 Search options – click the arrow beside the icon the following 
options are displayed: 
 

 
 
On the following pages is information on what the above menu options will do: 
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Select the Content Search  option and a field will be displayed as in the picture below:   
 

 
 

Enter your search text into the Content  filed then click the  button and the results will be 
displayed in the Middle pane.  The results displayed will show any documents where the text searched was 
located in the content. 
 
From the Search Option  menu select the All Document Reference search option then click the arrow 

beside the Add Document Reference   icon and from the list choose the Document Reference you 
wish to search and a field will be displayed: 
 

 
 
You would enter your search text into the field.  You will see in brackets that it states (is equal to) these 
operators can be changed please see section on Equality Type (operators) on page 153.  
 
For example we could search for any documents where the document reference Contact Name is equal to 

Sale BDM. 
 

Click the  button and the results will be displayed in the 
Middle pane. 
 
Also Document References sets such as Common, Fax Document 
References, Image Document References, Mail Documen t 
References or Office Document References can be used to search.   
 
Click one of the above document reference options, and they will be 
displayed in the Left-hand pane under the search for section. 
 
To select, click the arrow beside the Search Options  icon and click the 
required option.  The chosen option will be displayed in the search area. 
Image to the left shows multiple options selected, Contents search  and 
Office Document Reference search .  The Content is equal to 
Administration and Subject is equal to Training.    
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 Clear current search 
This icon, if selected, clears the current search from the screen including search criteria and results. 
 

 Saved Searches 
This icon will allow you to open previously saved searches please see page 160. 
 

 Refresh  
Will display any new data associated to the Document References for which other users may have inputted 
when filing and saving documents or changing data.  Click the Refresh  icon to check for any new 
information.  
 

 Equality Type (operators)  
When creating a search you can choose how a specific document reference will be compared.  These can 
also be known as Operators. 
 
By default when document references are added to the Search area the operators are set to Equals to  and 
And . Below is a list of available operators from the menu: 
 

Operators   

Logical  

AND 

All types of data OR 
NOT 

Comparison 

No value All types of data 
Equals String Date and Numerical 
Between  Date and Numerical 
Greater than  Date and Numerical 
Greater than or equal  Date and Numerical 
Less than  Date and Numerical 
Less than or equal  Date and Numerical 
Contains String Date and Numerical 
Begins With String Date and Numerical 
Ends with  String Date and Numerical 

 

 Add a Document Reference  
This icon allows you to add an unlimited number of additional Document References to the search criteria. 
 
For example the user could have two order number Document References and use the OR operator in 
between.  This means the user could search for two different order numbers at once. 
 
This feature is also used in conjunction with the All Document Reference Search see page 151 for more 
information. 
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Below the toolbar is where the search criteria can be selected. 
 

The first two drop down boxes are, in order, the Information Type  and the 
related Standard Documents .   
 
You can just search for certain types of documents.  
 
Find all documents of a particular Information Type and/or Standard 
document. 
 
If you choose a Standard Document (second drop down) the related 
Document References will be displayed as shown to the left. 
 
Tip : Remember the Information Type is the category of document i.e. Letter 
and the Standard Document the sub category i.e. Job offer letter. 
 

Each Document Reference displays a title (name of Document Reference), in brackets the operator and a 
text box where data to be compared is entered. 
 
To change the operator which appears next to Document References, click into the field of the Document 

Reference.  Click the drop down arrow beside the  Equality Type  icon and choose the relevant operator 
required for the search criteria. 
 

 
 
The example above shows changing from Equals  to Begins with .  
 
A search can also be performed on just the Information Type and or a Standard Document.  To search on an 
Information Type click the first drop down box and choose from the list then click the Search  button and the 
results will be displayed in the Middle pane.   
 
To search on just a Standard Documents click the second drop down box and choose from the list then click 
the Search  button and the results will be displayed in the Middle pane.   
 
If doing a search on Information Type then the related Standard Document(s), choose from both drop down 
boxes then click the Search  button and the results will be displayed in the Middle pane. 
 
If you wish to search by more than one Common Document Reference then an And  or Or operator will be 
required. 

Click the arrow beside the  icon from the list choose the Common  option.  All the Common 
Document References will be displayed on the next page: 
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Creator Equals  Jon Smith  
 
OR 
 
Owner Equals Jon Smith 
 
Enter the search criteria as shown in the picture to the left.  Click into the 
Creator  Document Reference field and click the arrow beside the 

Equality Type  icon.  From the menu choose the Operator OR; the 
text in brackets will change to include OR at the beginning. 
 

 
 
The example will find all documents with the Owner or Creator of 'Jon 
Smith' (if any).  
 
Once all search criteria has been entered click the Search  button to 
initiate the search and display the results in the Middle pane. 

 
The best way to learn this feature is to play! 
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Opening the Document in Context 
 
In any of the three modes you are able to open documents in context.  This will highlight the instances of the 
text searched within the document contents or document references. 
 
NB: Does not work through the doc. refs  button unless using the content option. 
 
For example if a user wishes to find all documents which have the word ‘Administration’  within its contents 
the search will show the associated documents.   
 
Once the search results are displayed in the Middle pane, right click the document and select the Open in 
Context option. 
 
The ‘View document’ screen will be displayed: 
 

 
 

At the top of the document will be the text ‘First Hit  ‘click the red arrow to go to the first instance where the 
text appears within the document. 
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Each instance of the text will be highlighted in yellow with a red arrow either side.  To move to the next 
instance click the red arrow on the right hand side of the highlighted text.   To move to the next or previous 
text instance click on the red arrows on the left and right hand side of the highlighted text. 
 
NB: The First Hit and navigation arrows will not work with image files. 
 

At the bottom of the Right-hand pane click the  button and the In context  Pane will be displayed: 
 

 
 
The Highlight  button allows you to change the colour of the highlight to show instances.  The default colour 
is yellow.  Click the Highlight  button and from the list choose the colour.  This will remain the default colour 
until changed. 
 
The Search within page  field will allow you to search the pages for different words within the same 
document.  To do this, enter a word / phrase into the Search within page  text box then click the Search  
button.   If the word is found within the document the selected word will be highlighted. 
 
In the area Context tree  you can expand the document to find out the number of matches of the search 
word. 
 
To close the 'Series 6 viewer' screen click the  button in the top right-hand corner of the window. 
 
View Location of Results 
 
When you have the result of a search in the Middle pane you are able to view the location of those results 
using in the Right-hand pane, 
 

To perform a search, at the bottom of the Right-hand pane click the  button and the following will be 
displayed as shown on the next page: 
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To view a document location click the document in the Middle pane and in the Result Locations  pane you 
will see where the document is located in Series 6. 
 

 
 
The Results Location  pane will also show which Intray a document is located in. 
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Saved Searches and Last Searches 
 
When you use the Search feature from any mode the Middle pane will show the summary screen this 
comprises of Saved searches  which allows you to view any searches you have saved to use again and Last 
searches  which will allow you to see a history of the last 10 searches performed. 
 

 
 

Standard  and Advanced  mode - the Saved Searches  icon is located in the Left-hand pane. 
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Simple  mode - the Saved Searches  icon is located in the right corner of the screen. 
 

If the summary screen is not displayed then click the arrow beside the Saved Searches   icon and from 
the menu select the Show Summary  option.  The summary will be displayed in the Middle pane of the 
Search. 
 
Saved Searches 
 
You are able to save searches you would like to keep which can then be run again at a later date. 
 
To save a search within the Search feature of any of the three modes enter the criteria and then click the 
Search  button to display the results in the Middle pane as shown below: 
 

 
 

Click the Saved Searches   icon and the following will be displayed: 
 

 
 
Enter Search description  and then click the OK button.  The search has now been saved. 
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View Saved Searches 
 

To view all saved searches click the arrow beside the Saved Searches   icon and from the menu select 
the Show Summary option. The following will then be displayed: 
 

 
 
To run a saved search double click the title of the saved search in the Saved Searches section in the Middle 
pane and the result will be displayed.   
 

To clear the search, click the  button which is located on the search toolbar in the Left-hand pane. 
 



 
 

  
Invu Services Limited © 2009 

Page 162 of 221 
End User Manual V 6.2.3 

 

Delete Saved Searches 

To remove a saved search click the arrow beside the Saved Searches   icon and from the menu select 
the Open… option. The following will then be displayed: 
 

 
 
To delete a saved search, highlight the search by clicking the title and then click the Delete  icon.  You 
would need to repeat this if you have more than one search to delete. 
 
Once you have finished, click the Close  button to exit the 'Saved searches' screen. 
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Last Searches 
 
The Last Searches will store up to the last 10 searches that you have performed.  
 

To show the Summary in the Middle pane of the Search click the arrow beside the Saved Searches   
icon and from the menu select the Show Summary  option. The following will then be displayed: 
 

 
 
In the area 'Last searches'  it will display the last 10 text and Document Reference searches performed.  To 
run a Last search  in the Middle pane double clicks the title of the last search and the results will replace the 
summary in the Middle pane. 
 
To clear the search, click the  button which is located on the search toolbar in the Left-hand pane. 
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Group and Filters 

Within the Middle pane of Search for all three modes is a Filter   icon, which enables you to select the 
way in which the results are displayed and filters the results further by selecting and deselecting where 
Series 6 will look.  The icon is located in the top right corner of the search area as shown below: 
 

 
 Standard and Advanced mode 
 

 
Simple Mode 
 

Click the Filter   button and the following pane will be displayed: 
 

 
 
In the Display grouping  area you can choose from a list of Common, Office, Image or Mail Document 
References which are used to sort the search results into groups.  The results can be grouped by one or 
more Document References. 
 
For example - you could group your search results by a common Document Reference called Creator  and 
then by Extension .  
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The Display Grouping 
 
In the Display grouping  areas click the drop down and choose Creator  from the drop down list and click the 
Add   button the Document Reference will be added to the list below.  Next click the drop down again and 
choose Extension  the click the Add   button the Document Reference will be added to the list below 
Creator  as shown below: 
 

 
 
Then click the Apply button and the search result will change as shown in the picture on the next page sorted 
by Creator  then by Extension . 
 

 
 
If you wish to order the document by creation date select the Group by creation cate  option, most recent 
will be displayed at the top.   
 

 
 
Select the Group by information type  option and the order will revert back to original group by Information 
Type and Standard Document. 
 
If you want no grouping in the Middle pane then select the No grouping  option. 
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If you wish to clear the 'Display grouping'  area click the Reset  button.   
 
 
The Filter Sections 
 
The Filter sections area enables you to filter out specific Information Types and Standard Documents on 
search results.  All the options in the Filter Sections  area are ticked by default.  The list consists of 
information Types and Standard Document. 
 

 
 
To filter out certain types of documents un-tick the relevant section within the list as shown below: 
 

 
 

If you wish to show only the Information Types/Standard Documents that are relevant for the files displayed 
in the Middle pane then tick the Show the current views filters/columns  check box filter selection list will 
be reduced as shown below: 
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Click the Apply  button and the relevant documents will be removed.  If you wish to clear the 'Filter Sections' 
area click the Reset  button.   
 
Display grouping and/or Filter section changes can be applied together if required. 
 
The filtered changes will remain as they are until changed by you during searching.  The options selected will 
also remain as they are if you log out and log back in. 
 
To remove any the Groups and Filters screen from the Middle pane click the Close  button. 
 
The Groups and Filters section will work independently in Explore, Workspace and Search. 
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OTHER DOCUMENT OPTIONS 
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INTRODUCTION TO OTHER DOCUMENTS OPTIONS 
 
In this section you will find out how to work with the documents using the right click menu.  You are able to 
convert, merge documents as well as create notes and attachments etc.. 
 

 
 
Each option on this menu will be explained what it is and how to use. 
 
 
Open 
 
The Open option will allow you to open the document for read only purposes.  For more information on how 
to open documents please see page 94. 
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Open in Context 
 
The Open in context  option will allow you to view the searched text and highlight the text in the content you 
where searching for.  For more information on opening documents in context please see page 156. 
 
 
Print 
 
The Print  option will allow you to print out a selected document.  This can be done from your Intray and from 
a Folder in the Filing Cabinets. 
 
To print a document, browse to the document in your Intray or Explore for the document or by Searching for 
the document.  In the Middle pane right click the document as shown below: 

 

 
 
From the menu select the Print option and the following will be displayed: 
 

 
 
Select the Printer , Page Range  and Copies , then click the Print  button to continue. 
 
 
Edit 
 
The Edit  option will allow you to edit documents you have access to from your own Intray or from the Filing 
Cabinets.  For more information on how to edit documents please see page 108. 
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Rename a Document in your Intray 
 
Within the Intrays you are able to rename a document no matter what type of document it is.  To do this right 
click a document in the Middle pane as shown below: 
 

 
 
From the menu click the Rename option and the following will be displayed: 
 

 
 
Enter the new title for the document and then click the OK button.  The document title change will be 
displayed as below: 
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Convert  
 
This feature is shown within the right click menu only but in all three modes.  This feature allows you to 
convert documents from multiple page documents to single page documents or many single page 
documents in a single document with multiple pages within it. This can be done on any tif document from 
your Intray only. 
 
Convert a Multiple Page Document to Single Page Documents 
 

 
 
The above document has four pages and we wish to split each page into a single page document. 
 
To convert files to a multiple page document, in the Middle pane right click the document and from the list 
Convert  then select the To single page documents  option.  The following screen will be displayed: 
 

 
 
In the Select where the documents are to be created  area you have two options: 
 
The In the same folder  option, if selected, will create the new files in the same location as the original. 
 
The In a subfolder called  option, if selected, will create a new folder in your Intray.  Enter the name of the 
new folder in the text box below the option. 
 
In The document title for each page  area you will need to enter a Title  for the new documents. 
 
The Delete the source file  check box, if ticked, will delete the original file you are creating the single page 
documents from. 
 
Click the OK button once you have set the options.  The document will be split in to single documents as 
shown below: 
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Convert to Multiple Page Document 
 

 
 
The above documents need to be amalgamated into one document.  
 
To convert, in the Middle pane click the first document the hold down the CTRL key and click each 
subsequent document or if the files you want to convert are in a block then click the first document then hold 
down SHIFT key then click the last document in the block. 
 
Hold down the CTRL or SHIFT key and right click the document.  From the right click menu click Convert  
then select the To multiple page document  option.  The following screen will be displayed: 
 

 
 
 
In The document title  area you will need to enter a Title  for the new document. 
 
The Delete the source file  check box, if ticked, will delete the original files you are creating the 
amalgamated document from. 
 
Click the OK button once you have set the options.  The selected documents will be joined together to create 
a single document as shown below: 
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Merge Documents 
 
The Merge Documents  option allows you to Cut or Copy a TIF document then Paste into another TIF 
document thus merging the two documents together.  The Merge Documents option will only be displayed 
when a TIF document is selected.  You must have the permission to edit the document and it’s not checked 
out or it’s checked out to you. 
 

 
 
This can be done from the Middle pane of Workspace (Intray), Explore or Search. 
 
Merge a Document using Copy and Paste  
 
This will make a copy of the selected document and paste it (append it) to the end of another document. 
 
In the Middle pane select source document, this is the document that will be appended to the selected 
destination document.  Right click the selected document, from the menu choose Merge Documents  option 
then click the Copy  option.       
 
Then browse to and select the document you wish to pasted the copied document into, right click the 
selected document and from the menu choose Merge Documents  option then click the Paste option. 
 
Both document will be check out automatically and the message "Documents Merging please wait ".  The 
source document will be appended to the end of destination document and the check out will be undone on 
the source document version (the one which was copied).  
 
When the documents have been merged the screen on the next page will be displayed: 
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The 'Check In' screen allows you to specify the type of revision made to the document. 
 
In the Action  area choose from one of the following options: 
 
New version  – if selected creates a new version of the document.  I.e. if version number was 1 this will 
increment to 2 or if the version number was 2.4 then the new version would be 3. 
 
New draft  – if selected creates a draft (meaning the document is a work in progress not the finished 
revision). The draft number will be based on the version created from and increment by .1.  I.e. if version was 
1 then draft would be 1.1 or if created from an existing draft 1.3 then new draft would be 1.4.  The document 
will be displayed in green text. 
 
In the Description  area, type brief notes of what was done to the document. This is for other users to review 
the comments made when checking in the revision. 
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The notes entered can have basic font and paragraph formatting applied using the toolbar above the notes 
area. 
 
Click the OK button to check in the new merged documents. 
 
Merge a Document Using Cut and Paste 
 
This will make a cut (remove the original) of the selected document and paste it (append it) to the end of 
another document.  The original version cut will then be deleted. 
 
In the Middle pane select source document, this is the document that will be appended to the selected 
destination document.  Right click the selected document, from the menu choose Merge Documents  option 
then click the Cut  option.       
 
Then browse to and select the document you wish to pasted the cut document into, right click the selected 
document and from the menu choose Merge Documents  option then click the Paste option.  
 
Both document will be checked out automatically and the message "Documents Merging please wait".  The 
source document will be appended to the end of destination document and the source document version (the 
one which was cut) will be deleted.  
 
When the documents have been merged the following screen will be displayed: 
 

 
 
The 'Check In' screen allows you to specify the type of revision made to the document. 
 
In the Action area choose from one of the following options: 
 
New version  – if selected creates a new version of the document.  I.e. if version number was 1 this will 
increment to 2 or if the version number was 2.4 then the new version would be 3. 
 
New draft  – if selected creates a draft (meaning the document is a work in progress not the finished 
revision). The draft number will be based on the version created from and increment by .1.  I.e. if version was 
1 then draft would be 1.1 or if created from an existing draft 1.3 then new draft would be 1.4.  The document 
will be displayed in green text. 
 
In the Description  area, type brief notes of what was done to the document. This is for other users to review 
the comments made when checking in the revision. 
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The notes entered can have basic font and paragraph formatting applied using the toolbar above the notes 
area. 
 
Click the OK button to check in the new merged documents. 
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File and Save 
 
The File and Save  option will allow you to file your document from your Intray to a Folder location in the 
Filing Cabinets.  For more information on how to file and save a document please see page 65. 
 
Publish To SharePoint 
 
The Publish To SharePoint  option will allow you to publish selected documents to a Share Point website.  
This option only appears if Sharepoint has been configure and the setting in Series 6 are also completed.  
For how to configure Series 6 please see the Technical Administration manual. 
 
Publish Documents to SharePoint 
 
Once the SharePoint settings have been configured and the Invu SharePoint Publisher Application has been 
installed you are now ready to go. 
 
To publish a document from Series 6 to SharePoint right click selected document in the Middle pane and 
from the menu select the Publish to SharePoint  option. 
 
Or if multiple documents need to be published click the first document in the Middle pane then hold down the 
CTRL key and click each subsequent document.  Keep the CTRL key pressed and in the Middle pane right 
click one of the documents selected and release the CTRL key.  From the menu select the Publish to 
SharePoint  option. 
 
You are able to Publish to SharePoint for both documents located in a Filing Cabinet folder or from an Intray. 
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If the SharePoint server is unavailable on start up of the SharePoint Publisher application, the user will be 
notified of this via a message box and informed the application will close.  Click the OK button and the 
application will safely shutdown but Series 6 will remain open. 
 
The application can only be started by Series 6. Do not attempt to locate the executable file and start it up 
the application as a message will inform you that the application can only be run from Series 6 and will now 
close. This will be followed by a safe shutdown of the application. 
 
Choose Publication Destination 
 

 
 
The Publishing Destination  section allows you to choose the site, sub site (if applicable) and then the 
Document Library (document type or similar).   
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The Publishing Destination list allows you to navigate the tree structure (nodes) from the SharePoint server.  
The tree structure symbols are explained below: 

 Root (Home) – the main site. Cannot publish to this destination 

 Site – sub site within the main site. Cannot publish to this destination 

 Document Library – document site within either the root or a site that declares the type of 
document it holds (i.e. columns and requirements). Can publish to this destination 

 Folder – document folder within a document library that inherits the document library column 
settings. 

NB:  Certain locations in your SharePoint site may be visible but inaccessible to publish to.  These are 
normally shown using a yellow triangle with an exclamation mark over a folder. 
 
Visibility of any of these nodes does not imply access to that particular area. Access will be attempted during 
the Publish process. 
 
Click the drop down arrow and expand the nodes  and then click the Document Library it will be displayed 
as shown below: 
 

 
 
Choose which documents you wish to publish 
 
Once a SharePoint destination folder has been chosen you can choose which documents you want to 
publish. 
 

 
 
In the Documents to Publish  section a list of files selected when you clicked the Publish to SharePoint  
option in Series 6 will be displayed. 
 
The documents which have a tick in the first column of this section will be published (when you click the 
Publish  button).  So for a document you don’t wish to publish yet un-tick the check box. 
 

If the document has mandatory metadata fields a  symbol will be displayed beside the check box as 
shown in the picture above.  The fields with this symbol must be completed with valid data. 
 
Check/amend the metadata  
 
In the Documents to Publish  click a document and the Metadata for that document will be displayed as 
long as you have also selected a Publishing Destination  (see page 180 for more information). 
 



 
 

  
Invu Services Limited © 2009 

Page 182 of 221 
End User Manual V 6.2.3 

 

 
 

Click into each field and enter the information i.e. Course Title  as shown in the screen above. 
 
Any changes made to the metadata whilst mutilple documents to publish are selected will be reflected to 
each file so they will have the same text. 
 

If a metadata field is mandatory a  symbol will be displayed in the text box and requires correct data to be 
entered before you publish the document.  Once all the mandatory metadata fields have been correctly 

entered the  symbol will disappear from the metadata text box and from the Documents to Publish  
section. 
 
If the documents you wish to publish are located in a Filing Cabinet folder the SharePoint Publisher 
application will attempt to populate the metadata with the values from the Document References as long as 
the data types and the Document Reference titles match the metadata of the chosen Document Library 
(document type).  The populated data can be edited if required.   
 

 
 
NB: Metadata changes are not reflected back to the actual file within Series 6.  
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The validation requirements of the metadata is provided by the SharePoint Site, Document Library 
configuration.  The following list shows the SharePoint validation options supported in version 1.0 of the 
SharePoint Publisher application: 

 Drop down list selection required 
 Drop down list selection not required 
 Text field required 
 Text field max number of characters 
 Text field number validation 
 Text field number range validation (i.e. 13 – 23) 
 Date Picker (drop down) Date field required 
 Date Picker (drop down) Date field not required 

A list of supported types not displayed above and how these are declared in SharePoint are provided in 
Appendix F of the Technical Administration Manual. 
 
The following list shows SharePoint validation options that are not  supported in version 1.0: 

 Person/Groups selection 
 Lookups 
 Time field required 

 
A list of non-supported types not displayed above and how these are declared in SharePoint are provided in 
Appendix D of the Technical Administration Manual. 
 
Preview  
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When you select a file from the Documents to Publish  area the section will attempt to show a read-only 
view of that file.  When viewing larger Tiff files (10+ pages) the viewer will only show the first 10 pages.  A 
panel will be displayed at the top of the Preview  section giving you the opportunity to load the entire file as 
shown below:   
 
NB:  Loading the full file may take some time to load up. 
 

 
 
The following file types will be supported in version 1.0 of the SharePoint Publisher application: 
 

 Tiff,tif,jpg,bmp,gif (Xps Viewer) 
 Txt,rtf (Xps Viewer) 
 Xps (Xps Viewer) 
 Pdf (Web Pdf Viewer) 
 Doc, docx,xls,xlsx,ppt,pptx (Web Office Viewer) 

 
All other Preview  document types, and any of the above that may fail to preview, will cause the Preview  
section to display notification that the file could not be previewed. In this instance, an option to open the 
document externally will be offered to allow you to try and open the file through the Operating System and 
relevant application. Version 1.0 will contain three different viewers for various types.  
 
The Xps Viewer allows navigation, zoom, rotation and multi-page views. The Web Pdf and Office versions 
are dependent on the versions of Acrobat and Office installed on the local machine respectively. As such, the 
functionality and experience of these web viewers is entirely sealed and therefore cannot be manipulated or 
influenced by the application. Browser settings, warnings and policy settings may have an impact of the 
ability of the viewer to display these documents. 
 
Any editing within these viewers is ignored by the publisher as when the document is published it will retrive 
the original file from Series 6.  If you wish to edit the document this must be done in Series 6 using the edit 
functions. 
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Publish document(s) 
 
If a destination has been selected and at least one document has been ticked and any required 
metadata has been completed the Publish  button will be enabled. 
 
Click on the Publish  button to publish the file(s) to a SharePoint site.  The following screen will be 
displayed: 
 

 
 

The above status bar will be displayed during the publishing process.  Click on the Stop  button to stop the 
process at any point.  A message will be displayed once finished telling you that the Publish is complete as 
shown in the screen on the next page:  
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If you had any un-ticked files then they will still be displayed otherwise if all documents were ticked the 
publisher screen will be empty as shown above. 
 

Click the  button to exit the SharePoint Publisher application. 
 
Notes: 
 
If the documents published came from an Intray then the document will be moved from your Intray into an 
Archive area or a relevant Filing Cabinet configured in Series 6.  If the document comes from a filing cabinet 
location then it will remain there. 
 
Publish will fail if the required metadata is not completed correctly.  You will be notified through a progress 
bar message. 
 
If the publish is successful the document is removed from the Document to Publish  section. If the 
document resides in an Intray, it will be removed from the Intray as mentioned above. 
 
If a document fails to publish the application will continue to the next document within the Document to 
Publish section. A document that fails to publish will display a yellow warning triangle.  Click the triangle, you 
will see the cause of the failure. In this case, the document is not removed from the Document to Publish 
section (or the Intray if relevant). 
 
If you do not have access to the Publishing Destination, each document will fail and display a warning 
notification. 
 
If access to Series 6 for any particular document fails during the publish process, the publishing of that 
document will also fail and a warning notification will be displayed.   
 
For more information on assumptions and limitations please see the Technical Administration Manual. 
. 
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Start Workflow  
 
This feature is shown within the right click menu only but in all three modes.  This feature allows you to start 
a workflow on a document that sits in your Intray and a filing cabinet location.  This option is only shown if 
you have the correct licence and privileges which are assigned by the System Administrator.  Please see the 
the Technical Workflow Manual for more information. 
 
 
Check out 
 
The Check out  option will allow you to check out a document ready for you to edit at a later point.  For more 
information about check out and how it works please see page 108. 
 
 
Check in 
 
The Check in  option will allow you to check in a new version of the document you have been editing.  For 
more information about check in and how it works please see page 109. 
 
 
Undo Check out 
 
The Undo check in  option will allow you to cancel a checked out document as long as the document 
belongs to you and if not you have the correct privileges applied please see page 114. 
 
 
Mark as read / Mark as unread 
 
The Mark as read  / Mark as unread  options will allow toy to mark an unread document as read and a read 
document as unread please see page 54. 
 
 
Create 
 
This feature is shown within the right click menu only but in all three modes.  This feature allows you to 
create a response, new copies and also notes to a selected document. 
 

 
 
 

Respond 
 
The Respond…  option is a way to respond to a document within Series 6.  You can also perform a similar 
function by using the File and Reply feature please see page 79. 
 
In the Middle pane right click a document then click the create option and then from the right click menu 
select the Respond… option.  The screen on the next page will be displayed: 
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In the ‘Documents ’ tab you can create new documents (in many different file formats). 
 
To create the reply document first, type the Document Name  and click the drop down and choose the 
required File Type . 
 
If a Template  is required when creating a document, click the drop down and choose a template from the 
list. Want to create a blank document then leave the option <Use Default>  selected. 
Click the OK button and the document will be created in the chosen format. 
 
Enter the text into the document in the normal way then close and save the file.  The document will be 
brought into your Intray and the 'file and save document' screen will be displayed. 
 
File and save the document as normal (for more information please see page 65) and click the File and 
Save button.  The document saved will then be attached to the original document responded to. 
 

 
 
In the Standard or Advanced mode go to the ’Explore ’ tab.  At any time after the document has been saved 
it can be re-filed and saved.  A small paper clip symbol will be displayed before the title of the document both 
on the original and the reply. 
 
NB:  To view the attached document please see page 204. 
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New Copy 
 
The New Copy  option would be used to create new copies of existing documents which are then placed into 
your Intray. 
 
In the Middle pane right click the document you wish to create a copy of, then from the right click menu 
select the Create option and then click the New Copy  option.  The following message will be displayed: 
 

 
 
As the message states a new copy of that document is now in your Intray. 
 
NB:  The copy is not linked to the original in any way. 
 
Note 
 
The Note option would be used to create and attach notes to a selected document.  This document can be 
located either in Workspace - Intray or Current documents or Explore or Search with in the Middle pane.  
These notes are known as simple notes. 
 
Add a Note 
 
To add a note, in the Middle pane right click the document you wish to add a note to.  From the right click 
menu select the Create option and then click the Note option.  The following screen will be displayed: 
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Add the text for your note which can be formatted using the toolbar to change font style, size, alignment etc.  
Once finished click the OK and the 'Title' dialogue will be displayed: 
 

 
 
Enter the title (by default the title will be picked up as the first line of your note.  Once you have finished, click 
the OK button to save the note and exit the screen. 
 
The note will be saved in the same location as the actual document but under the heading of Notes .  If you 
file and save the document away the note will move to the new location as well.  When a note is added to a 

document a note  symbol will appear to the left of the title as shown below: 
 

 
 
The note itself will be placed in a section called Note as shown on the previous page. 
 
Open a Note 
 
To open a note, find the document that has a note attached and in the Middle pane highlight it.  In the Right-

hand pane make sure the  Summary and Notes  pane is displayed: 
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Once in the Summary and Notes  pane you will need to click the  icon and the notes section will be 
displayed:   
 

 
 

To view the note double click the title in the notes section or right click the note in the Right-hand pane and 
select the Open option.  The 'View Document' screen will be displayed as shown on the next page: 
 

 
 
Click the X in the top right corner of the screen to close. 
 
You can print out or view the information on your note.  For more information regarding the 'View documents' 
screen please see page 116.  To close the screen click the File  menu then select the Exit  option or click the 
X in the top right corner. 
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Print a Note 
 
To print a note, find the document that has a note attached and in the Middle pane highlight it.  In the Right-

hand pane make sure the  Summary and Notes  pane is displayed. 
 

Once in the Summary and Notes  pane you will need to click the  icon and the following will be displayed: 
 

 
 

Right click the note title in the Right-hand pane and select the Print  option.  The following will be displayed: 
 

 
 
Select the Printer , Page Range  and Copies , then click the Print  button to continue. 
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Edit a Note 
 
To edit a note, find the document that has a note attached and in the Middle pane highlight it.  In the Right-

hand pane make sure the  Summary and Notes  pane is displayed. 
 

Once in the Summary and Notes  pane you will need to click the  icon and the following will be displayed: 
 

 
 

Right click the note title in the Right-hand pane and select the Edit  option.  The screen on the next page will 
be displayed: 
 

 
 
Here you are able to add new sections (tabs) or even new pages.    
 
NB:  You cannot add text to existing sections (tabs) you will have to create a new one. 
 
For more information on how to add pages please see page 19 and for more information on how to add new 
sections please see page 20. 
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Delete a Note 
 

To remove a note, once in the Summary and Notes  pane you will need to click the  icon and the 
following will be displayed: 
 

 
 

In the notes section right click the note you wish to remove.  From the right click menu select the Delete  
option. 
 

 
 

Click the Yes button to remove the note.  The note will be removed from the notes section and the note  
symbol will be removed from the document it was attached to. Click the No button to cancel the deletion. 
 
 
View 
 
The View options will allows you to choose how you wish to view the documents in the Middle pane.  For 
more information regarding the view option please see page 39. 
 
Delete 
 
The delete option will allow you to remove documents from Series 6.  For more information on deleting 
documents please see page 106. 
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Send To 
 
This feature is shown within the right click menu only but in all three modes.  This feature allows you to send 
selected documents from your Intray or a filing cabinet location to your Workspace  - Current documents, 
Email as an attachment, Favourites as a shortcut or the Windows Desktop. 
 
This feature is available to use in your Intray , Explore  and Search  Middle pane. 
 

 
 
NB: All functionality on the right click menu is governed by the privileges given to the user. Certain functions 
may not be available. 
 
Send to - Workspace 
 
The Workspace  option allows you to send a read only  copy of the document to 'Current Documents' in the 
Workspace.  This is like putting something on a desk to read later.  This is useful as the document will be 
available 'offline' when not connected to Series 6 via a network or the internet. 
 
To Send to the Workspace, in the Middle pane right click the required document or if you want to send 
multiple documents highlight the first document then hold down the CTRL key and click each subsequent 
document.  If the documents you wish to select are in a block then highlight the first document then hold 
down the SHIFT key then click the last document in the block. 
 
Right click one of the highlighted documents, from the menu select Send to  and from the cascade menu 
click the Workspace  option.  The copies of the document will be sent to Current Documents.   
 
To access Current Documents, in the Simple mode the Workspace area is known as ‘My Work’.  Click the 

'My Work ' tab to access the Workspace area.  To access the Workspace in the Standard mode click the  

button on the floating toolbar or if within the Advanced mode click the  button on the Left-
hand pane. 
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In the Left-hand pane click the  option and in the Middle pane you will be able to browse the 
documents sent to the Workspace these will appear in black as shown in the picture above.  
 
Send to - Email… 
 
The Send to - Email option allows you to send a document to a blank email as an attachment. 
  
To Send to an Email, in the Middle pane right click the required document or if you want to attach multiple 
documents highlight the first document then hold down the CTRL key and click each subsequent document.  
If the documents you wish to select are in a block then highlight the first document then hold down the SHIFT 
key then click the last document in the block. 
 
Right click one of the highlighted documents, from the menu select Send to  and from the cascade menu 
click the Email…  option.  The copies of the document will be sent to current documents.   
 
The email screen will then be displayed.  The screen on the next page shows a new email from MS Outlook 
(other email systems are also supported).  
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The documents selected will be attached as shown on previous page.  Complete the email as normal and 
then click the Send button. 
 
NB: As the email is created in the appropriate email application (such as MS Outlook) full email functionality 
is available. I.e. Address books, signatures, stationary, etc. 
 
Send to - Favourites 
 
The Send to - Favourites  option allows you to send a document to the Favourites  Pane.  This creates a 
shortcut to the document.   
 
To Send to favourites, in the Middle pane right click the required document or if you want to select multiple 
documents highlight the first document then hold down the CTRL key and click each subsequent document.  
If the documents you wish to select are in a block then highlight the first document then hold down the SHIFT 
key then click the last document in the block. 
 
Right click one of the highlighted documents, from the menu select Send to  and from the cascade menu 
click the Favourites option.  Shortcuts to the documents will be created. For more information on the 
Favourites  pane please see page 35. 
 
Send to - Desktop 
 
The Send to - Desktop  option allows you to send a copy of a document to your Windows desktop.  The 
copy of the document is sent to your desktop will not affect the document stored within Series 6. 
 
To Send to your Desktop, in the Middle pane right click the required document or if you want to select 
multiple documents highlight the first document then hold down the CTRL key and click each subsequent 
document.  If the documents you wish to select are in a block then highlight the first document then hold 
down the SHIFT key then click the last document in the block. 
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Right click one of the highlighted documents, from the menu select Send to  and from the cascade menu 
click the Desktop option.  The document is then copied and placed on the user's desktop. 
 

 
 
The document will show the Invu number in square brackets as shown above. 
 
Send to - Document Template  
 
When creating new documents you have the option to choose a document template to base the document 
on.  For more information regarding creating documents please see page 99. 
 
This option allows the user to add templates to the Document Templates area which is located in Explore 
(only available in Standard or Advanced Mode). 
 
To add a new document template bring the file into your Series 6 Intray then right click the template in the 
Intray.  From the right click menu choose Send to  and then the Document Template  option. 
 
You will then need to speak to your systems administrator to finish off the Document Templates configuration 
or refer to the Technical Administration Manual. 
 
Export 
 
The Export option allows you to export out the documents and the information that goes with it, this can e 
useful if alot of documents have been filed in the wrong place.  
 
This is only available if you have been given the privilege by the Series 6 Administrator.   
 
To Export, in the Middle pane right click the required document or if you want to export multiple documents 
highlight the first document then hold down the CTRL key and click each subsequent document.  If the 
documents you wish to select are in a block then highlight the first document then hold down the SHIFT key 
then click the last document in the block. 
 
Right click one of the highlighted documents, from the menu select the Export  option and the ‘Export’ screen 
will be displayed as shown on the next page: 
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You will need to set what to export and where the data and files will go this is explained below: 
 
In the Items to export  area tick the Document Files  check box to export the actual documents selected.  If 
you would like to export all versions of the selected document the tick the All Version  check box.  If you 
want to include the File and save information (Information Type, Standard Document and Document 
References) then tick the Indexing Information  check box. 
 
In the Information  area will show you what you have selected and the estimated space required. 
 
In the Exported Data  area you can choose where to put the XML file that will be exported with the 
information about the exported items.  By default the xml file will be saved into your My documents folder but 

if you wish to store it else where, click the  button and choose the where the xml file will be exported to 
and give a file name but make sure you add the file extention of .xml then click the Save button.  If the file 
already exists in the chosen location then tick the Overwrite  check box. 
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In the Export Transformation Options  area you can choose a Transform Type: 
 

 Export Data as XML Only(No Transformation)  – will create the XML file but not transform the data 
into a more readable format. 

 Export Data as XML and Default CSV Transform  – will create the XML file then trans form the 
data into a CSV format which could be used with Link Manager. 

 Export Data as XML and Default HTML Transform  - will create the XML file then trans form the 
data into a HTML format which gives you a nice report format. 

 Export Data as XML and User Specified Transform  – will create the XML file and allow you to 
create your own XSL Transform file.  When this option is selected the XSL Transform  and File 
Extetion  fields are enabled as shown below: 

  

 
 

You will need to select the XSL Transform  file, click the  button and browse to the location of the xsl/xslt 
file and click the Save button.  Click the drop down for the File Extention  field and choose the file the XML 
data will be transformed into.  If you choose the Other  option you will need to enter the extention into the 
field that is enabled (see below). 
 

 
 
In the Exported Documents  area you can choose where the documents will be exported to.  By default the 
documents will go to your My documents folder but if you want to point them else where   
 

 
 
By default the documents will go to your My documents folder but if you want to point them else where then 

click the  button browse to the location and click the OK button.  If the documents have been exported 
before you may wish to tick the Overwrite  option. 
 
Once you have completed the ‘Export’ screen click the Export  button and the following message will be 
displayed: 
 

 
 
Click the OK button to close the message. 
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The files will be exported to the chosen location the documents will be stored in separate folders depending 
on where they were stored in the Series 6 system. 
 
Below is examples of how the different Transform options would look. 
 
Export Data as XML Only(No Transformation)   
 

 
 
Export Data as XML and Default CSV Transform   
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Export Data as XML and Default HTML Transform   
 

 
 
In this format you are able to click the document location and view the document. 
.
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Copy to Clipboard 
 
The Copy to clipboard enables the user to copy the contents of the Middle pane to clipboard this could then 
be pasted into Word or Excel.  You can use this feature for your Intray, filing cabinets locations or even 
Search results Middle pane.  This would be extremely useful to copy the results of a search.  
 
To copy the contents, first browse to the correct Middle pane then right click a document in the Middle pane.  
From the right click menu choose the Copy to clipboard  option.  Open an application such as Microsoft 
Word, Excel or Note Pad and paste in as normal example shown below: 
 

 
 
NB: All functionality on the right click menu is governed by the privileges given to the user. Certain functions 
may not be available. 
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Attachments 
 
Attachments are used to associate one document to another within Series 6.  For example if you have a 
statement you could then attach all the related invoices to it. 
 
You can create attachments on any documents within Series 6 and a document can have many attachments.  
The attachment feature is available through documents in the Middle pane of Workspace, Explore and 
Search.  This feature will allow you to see what has been attached to a document, review the documents it’s 
attached to, add new attachments and also remove existing attachments. 
 
Create an Attachment 
 
To create an attachment, first right click the required document.  From the right click menu choose the 
Attachments…  option and the following screen will be displayed: 
 

 
 
First choose which type of attachment needs to be created.  On the toolbar there are two types of 
attachments that can be applied. 
 
Ensure that the Has Attachment  button is selected, it will be highlighted in orange as shown 
below. 
 

 
 
Click the  button and the following screen will be displayed as shown on the next page: 
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Here you can perform most of the functionality in Series 6 such as Explore  or Search .   
 
Browse Series 6 to find the documents you wish to attach. For example the outlines need to be attached to 
the manuals.  Highlight the document to be attached as shown in the picture above.   
 
If you want to select multiple documents highlight the first document then hold down the CTRL key and click 
each subsequent document.  If the documents you wish to select are in a block then highlight the first 
document then hold down the SHIFT key then click the last document in the block. 
 
Once the document(s) have been highlighted, click the OK button to attach the document. 
 



 
 

  
Invu Services Limited © 2009 

Page 206 of 221 
End User Manual V 6.2.3 

 

 
 
The document(s) will then be displayed in the 'Attachments' screen.  Click the Close  button to return to 
Series 6. 
 

 
 

In the picture above documents with attachments will display  symbol just before the title. 
 
View Attachments 
 
To view documents attachments right click a document.  From the right click menu select the Attachments… 
option.   
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There are two types of attachments: 
 
The Has attachments  button which is the default will list all documents that are attached to the 
document you right clicked. 
 

The Is attached to  button, if selected, will list documents that the document you right clicked is 
attached to. 
 
Click the document in the list to view the Summary information in the Right-hand pane.  Double click the 
document in the list to open the document in the 'View Document' screen. 
 
Delete Attachments 
 
To remove a document from the attachment list first choose which type of attachment to view then highlight 

the document and click the  button from the toolbar.   
 

The  symbol will be removed from the document in the Middle pane. 
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Properties 
 
The document properties allow you to view information about a specific document.  The screen has three 
tabs General, Security, and Event History (depending on privileges set by System Administrator).  You view 
the Properties of a document from the Middle pane of Workspace, Explore and Search. 
 
To access the document properties, in the Middle pane right click the selected document.  From the right 
click menu select the Properties  option. The 'Properties' screen will be displayed. 
 
The General Tab 
 

 
 
The 'General ' tab show you general information about the document such as the full name, Type, the Size of 
the document, the date and time of when the document was Created /Modified , the Version  control details 
and Summary and Notes (for more information on summary and notes please see page 13). 
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The Security Tab 
 

 
 

The 'Security ' tab shows you the access rights setup for the folder the document is located in.  Depending 
on the Access Rights set for the user, this is a read only area. 
 
The Event History Tab 
 

 
 
The 'Event History ' tab will allow you to view the document's events (audit information) on a daily basis such 
as when it has been Checked out/in, Edited, Viewed, File and Saved etc… 
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To view the details of an event and any supporting details click the specific row underneath the headings. 
Name, Workstation and Date and the detail will be displayed below the Details  section. 
 
The actual events can be sorted by Name, Workstation and Date in ascending or descending order. 
 
For example to sort the events by Date (and time) click the Date heading and the  ascending order arrow 
will be displayed to the right of the heading.  To change the order to descending click the heading again and 
the  descending order arrow will be displayed. 
 

 
 
If you wish to only see Workflow events tick the Show Workflow only  check box and the list above will 
change. 
 

 
 
When finished with the 'Properties' screen click the Cancel  button or the X in the top right-hand corner of the 
'Properties' screen to return to the Series 6.  
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OFFICE ADDIN 
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THE OFFICE ADDIN 
 
The Series 6 Office Addin will allow you to file documents from within the Microsoft Office Suite. Installed as 
part of the Series 6, the Office Addin can be used as part of MS Word/Excel/PowerPoint/Outlook the Office 
Depending on the version of Office will depend on how the Office Addin toolbar will be displayed. 
 
If using Office 2000, Office XP and Office 2003 then the Office Addin will be displayed as below: 
 

 
 
 
OR  

 
 
 
The Office Addin can be accessed by the Invu  menu on the menu bar of the MS application.   
 
If using Office 2007 will be displayed as below:  
 
The Office Addin is located within the Add-Ins  ribbon as shown below. 
 

 
 
OR  
 

 
 
The menu commands area click the Invu  and the following menu will be displayed: 
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Office Addin Options 
 
No matter what version of Office you are working with to access the options for Word, PowerPoint and Excel, 
click the Invu  menu then select Options . 
 

 
 
The 'Options' screen will enable the user to determine how the MS application and Invu will behave.  If all the 
check boxes are greyed out it means that these are controlled centrally by the Series 6 Administrator. 
 

 
 
Every time a file is saved if the Process the save event  check box is ticked it will enable the user to choose 
what happens to the document. 
 
Choose one of three options: 
 
File and Save in Series 6  which sends the document into Invu and displays the File and Save screen. 
Send to my Intray  which sends the document straight to the users Intray. 
Save the document  which will save the document as normal in word and will not go to Invu. 
 
Click the OK button. 

 
 
Always save new document to Invu  - each time a document is saved normally the choice of saving option 
such as File and Save into Series 6, send to the Intray or just save in the application will be displayed but 
when Always save new document to Invu  option is ticked the save options are bypassed and the 'File and 
Save document' screen will be displayed.  File and Save the document as normal.  For more information on 
filing and saving a document go to page 65.   
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NB:  This option is only available if Process the save event  has been ticked. 
 
Move documents to Invu  - if ticked this option will move the original file into Series 6 when sent for File and 
Save or to the Intray.  If not ticked when a file is sent to Indexing or the Intray the document will be copied 
into Invu and the file will remain in its original location. 
 
Disable Auto save feature  - If ticked will disable the auto save feature in the MS Application. 
 
NB: By default the Process the save event and Always save new documents to Series 6 check boxes 
are not ticked. 
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Tool Button Style  - click the drop down list and choose from Caption and icon  (which is the default), 
Caption only  and Icon only .  These options will determine how the Addin toolbar will look as shown below: 
 

 Icon only 
 

 Caption and icon 
 

 Caption only 
 
 
If using Outlook the Office Addin options are slightly different, click the Invu  menu then select Options . 
 

 
 
If the check box Delete mail items when sending to Series 6 is ticked the email would be deleted from 
Outlook when moved into Series 6. 
 
The Tool Button Style works the same way as for Word, Excel and PowerPoint. 
 
Click the OK button once finished. 
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 About The Office Addin 
 
Click the Invu  menu then select About  and the following screen will be displayed: 
 

 
 
This shows details on the Office Addin version, the host application (i.e. Word) and version.  To exit click the 
Close  button. 
 
 
Manually send a document to the Intray from an MS A pplication 
 
To place an MS file into a user’s Intray in Invu click the Send to my Intray  icon and the following screen will 
be displayed:  
 

 
 
Type in the name of the document and click the OK button.  The document will then be sent to the Intray. 
 
 
Manually File and Save a document from MS Applicati on 
 
To File and Save an MS file into the Filing Cabinets.  Click the File and Save Document  icon and the 
following screen will be displayed:  
 

 
 
Type in the name of the document and click the OK button.  The document will be displayed in the 'File and 
Save document' screen. 
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File and Save the document as normal.   
 
 
 
 



 
 

  
Invu Services Limited © 2009 

Page 218 of 221 
End User Manual V 6.2.3 
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APPENDIX 1 - LOGIN SCREEN IF OUTSIDE THE NETWORK 
 
If the user is outside the network the following screen will be displayed: 
 

 
 
The user will need to login.  Enter the Server location\username and password.  Check the Server is correct 
or choose from the drop down list.  Click the Login  button. 
 
 
APPENDIX 2 - LOGIN OFFLINE 
 
This will allow you to login and work with current documents when not connected to the Series 6 system.  To 
login offline to Invu, first double click the following Icon which will be located on the desktop. 
 

 
 
Series 6 will start to login and the following message will be displayed: 
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Click the Yes button and the Current documents section will be displayed: 
 

 
 

In offline mode you will only be able to see documents which are Checked out (See page 108) or sent to 
Workspace (See page 195) as a read only copies. 
 

Once finished in offline mode click the X button in the top left of the screen. 
 
NB:  You must have logged into Series 6 on the network once before the offline mode will work. 


